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NOVEMBER 8, 2004 KJS 

SYNTHESIS OF SUBSURFACE FRACTURE DATA COLLECTED AT YUCCA 
Mou NTAI N, NEVADA 

AUTHORS: K.J. Smart, P. Landis, D. Waiting, D. Wyrick, D. Sims, D. Ferrill, N. Franklin. 
A. Morris 

OBJECTIVES 

The objectives are to compile and synthesize all available subsurface fracture data 
collected at Yucca Mountain, and to analyze the data for use in areas such as 
performance confirmation, drift degradation, and flow in the unsaturated zone. The data 
sets include detailed line surveys (DLS) and full-periphery geologic maps (FPGM) 
collected by the Department of Energy (DOE) and it’s contractors (e.g., U.S. Geological 
Survey, U.S. Bureau of Reclamation) in the Exploratory Studies Facility (ESF) and the 
Enhanced Characterization of the Repository Block (ECRB) Cross-Drift. This analysis 
will provide the Nuclear Regulatory Commission (NRC) staff and its contractors with a 
complete, up-to-date summary of fracture characteristics at Yucca Mountain that can be 
used during license review to evaluate features, events and processes related to 
repository construction and operation. 

SPECIFIC TASKS 

Tasks to be completed during this work include: 
1. Compiling DLS fracture data - initial analyses by K.J. Smart are documented in 

Scientific Notebook 606E (p. 29-46), and will be continued in this notebook. 
2. Extraction of fracture data from FPGM - P. Landis and D. Waiting 
3. Generation of synthetic fracture populations with FracMan - D. Wyrick 

3 
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December 20, 2004       PSL          

EXTRACTION OF DATA FROM FULL-PERIPHERY GEOLOGIC MAPS (FPGM)

The following entries describe the process by which data was extracted from the FPGMs for the
ECRB (DTN: GS990408314224.003 - DTN: GS990408314224.006).  All entries in the following
section were made by Paul Landis unless otherwise noted in the text.  All files in bold will be
provided in the electronic notebook.  Furthermore, since this process only details one 100m
section of the ECRB, all files from the ECRB will be provided.

ENTRY 1: TURBOCAD DATA EXTRACTION

The ECRB files are provided in two formats: .dxf and .dwg.  A four digit number describing the
station (ie. Cbd2200.dxf) precedes the file extension.  Only .dxf files were used in the ECRB
data extraction process.  To begin the data extraction process, open TurboCAD v10.2 and open
the target ECRB file (the file cbd2200.dxf will be used).  The DOE grouped the full-periphery
geologic maps into three panels.  To ungroup them, select the panel and explode the panel
(ctrl-alt-E).  Under the ‘Options’ menu, select ‘Layers’ and delete the following layers in the pop-
up box:

• Tunnel
• Title
• Spline
• Store
• St-Nets
• TOP_PNL
• BOT_PNL
• GRID1
• 10GRID
• TXT3
• RQD
• 61-100
• S61-100
• DIP
• BLANK
• AME-FRZ
• CAT
• TBM
• TXT2-5
• TXT2
• 23-2200C
• 23-2200C1 - C7
• CLUS1CNT
• HATCH
• 23-2200S
• 23-2200S2 -S7
• All files with the XSEC2200$1$ prefix
• XNDX2200$0$STEEL
• XNDX2200$0$STLTXT
• XNDX2200$0$RKBLT
• XNDX2200$0$END
• XNDX2200$0$MESH
• XNDX2200$0$CENTER
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• XNDX2200$0$SPRINGLINE
• XNDX2230$0$STEEL
• XNDX2230$0$STLTXT
• XNDX2230$0$RKBLT
• XNDX2230$0$END
• XNDX2230$0$MESH
• XNDX2230$0$CENTER
• XNDX2230$0$SPRINGLINE
• XNDX2260$0$STEEL
• XNDX2260$0$STLTXT
• XNDX2260$0$RKBLT
• XNDX2260$0$END
• XNDX2260$0$MESH
• XNDX2260$0$CENTER
• XNDX2260$0$SPRINGLINE

Save the altered .dxf as cbd2200.fpg.dxf and close TurboCAD.

ENTRY 2: EXTRACTING STRIKE AND DIP DATA

Open the application ArcMap 9, create a new map and add cbd2200.fpg.dxf as new data. 
Under the ‘Selection’ menu, choose ‘Select by Attributes’.  The dip data is embedded in the
cbd2200.fpg.dxf point layer and needs to be extracted.  Enter the following formula in the query
calculator:

“DIP” > 0
This formula creates a new selection from the point shapefile.  Click ‘Apply’ and then ‘Close’. 

Right-click on the cbd2200.fpg.dxf point shapefile and select the ‘Data’ option.  Under ‘Data’
select ‘Export Data’.  In the popup menu specify that you want to export the selected features
and then specify the path name where you want to save the file.  I chose to name the file
2200dip.shp.  Click ‘Ok’ and add the data as a new layer.

To extract the strike data, choose the ‘Selection’ menu and ‘Select by Attributes’ again.  This
time, specify the cbd2200.fpg.dxf polyline shapefile as the target.  In the query calculator input
the following formula: 

“Layer” = ‘XNDX2200$0$FRAC’ OR “Layer” = ‘XNDX2230$0$FRAC’ OR
“Layer” = ‘XNDX2260$0$FRAC’ OR “Layer” = ‘XNDX2200$0$VPP’ OR
“Layer” = ‘XNDX2230$0$VPP’ OR “Layer” = ‘XNDX2260$0$VPP’ OR
“Layer” = ‘XNDX2200$0$FAULT’ OR “Layer” = ‘XNDX2230$0$FAULT’
OR “Layer” = ‘XNDX2260$0$FAULT’ OR “Layer” =
‘XNDX2200$0$SHEAR’ OR “Layer” = ‘XNDX2230$0$SHEAR’ OR “Layer”
= ‘XNDX2260$0$SHEAR’

This formula lists all the possible layers that were mapped as having measurable offset (faults,
fractures, shear, vapor phase partings).  Many full-periphery geologic maps do not contain all of
the above layers and the formula needs to be adjusted accordingly.  The number after XNDX is
the station number.  Click ‘Apply’ and then ‘Close’. 

Right-click on cbd2200.fpg.dxf polyline and choose the ‘Data’ option.  Under the ‘Data’ option,
choose ‘Export Data’ and specify that you want to export selected features and specify the path
where you want to save the file.  I chose to name the file 2200all.shp.  Click ‘OK’ and add the
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data as a new layer.

In the Editor toolbar, select ‘Start Edition’.  The target should be 2200all.shp and the task is
‘Modify Feature’.  Under the ‘Selection’ menu choose ‘Select by Attributes’ and specify that the
layer to select from is 2200all.shp.  In the query calculator input the following formula:

“Text” = ‘XNDX2200$0$FEND’ OR “Text” = ‘XNDX2230$0$FEND’ OR
“Text” = ‘XNDX2260$0$FEND’

Click ‘Apply’ and ‘Close’.  This formula selects the polylines that were constructed in CAD by the
DOE as the fracture endpoints.  Using the Edit select tool, right-click on a selected feature and
choose ‘Delete’.  In the Editor menu, ‘Save Edits’ and then ‘Stop Editing’.

ENTRY 3: JOINING STRIKE AND DIP DATA

Right-click on the 2200frac.shp file, choose ‘Joins and Relates’ and then ‘Join’.  In the drop
down menu select ‘Join data from another layer based on spatial location’.  A variety of options
will pop up.  Make sure that ‘the layer to join this data or load spatial data from disk’ is
2200dip.shp.  Rename the joined file as 2200all_data.shp.  Click ‘OK’.  The new shapefile
should be added as a layer.

Under the ‘Selection’ menu, select ‘Select by Attributes’.  The target layer is 2200all_data.shp. 
Enter the following formula in the query calculator:

“Distance” > 0.2

‘Apply’ and then ‘Close’.  This formula selects all the fracture traces that are more than 0.2m
away from a dip measurement.  In the editing toolbar, select ‘Start Editing’.  Right-click on
2200all_data.shp and ‘Open Attribute Table’.  In the attribute table choose show: selected. 
Replace all the selected values in the Strike_1 column and the Dip_1 column with 0.  In the
editing toolbar, select ‘Save Edits’ and then ‘Stop Editing’.

ENTRY 4: EXTRACTING COORDINATE DATA

Launch the application ArcView GIS 3.2a.  Create a project with a new view and add the theme
2200all_data.shp.  Under the ‘Theme’ menu, select ‘Start Editing’.

The next step is somewhat arbitrary.  A number of the fractures contain drafting errors that
greatly exaggerate the total trace length.  For example, many fractures are digitized numerous
times.  In order to fix this problem, select the ‘Vertex Edit’ button in the main toolbar and then
select a fracture that is digitized multiple times.  To delete the multiple points, place the cursor
near the extra points and press ‘Delete’ on the keyboard.  Repeat until a single continuous
fracture remains.  In the ‘Theme’ menu, ‘Save Edits’ and then ‘Stop Editing’. 

In the ‘File’ menu under ‘Extensions’ select the ‘Get Vertices’ extension.   This will add a ‘XY’
button in the main toolbar.  Click the ‘XY’ button.  Specify the theme as 2200all_data.shp in the
pop-up box and select ‘Ok’.  In the next popup box the name field for the theme is FID_1.  A
table displaying coordinate data for all fractures will load.  Under the ‘File’ menu, select ‘Export’
and specify the format as dBASE.  Name the file 2200frac_coor.dbf.  Click the ‘XY’ button
again and this time specify the Strike_1 theme and export the table as 2200strike.dbf.  Once
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more, click the ‘XY’ button and specity the Dip_1 theme and export the table as 2200dipxy.dbf. 
Close ArcView GIS 3.2a.

ENTRY 5: EXTRACTING TRACE LENGTH

Open the application Microsoft Excel and open the file 2200frac_coor.dbf.  The format should
be as follows: column A is FID1, column B is XCOORD, and column C is YCOORD.  If not,
rearrange the columns to match the format. 

The next step involves a series of conditional formulas that will eventually result in a total trace
length for each fracture.  In column E input the formula:

=IF(A2=A3,SQRT((B2-B3)^2+(C2-C3)^2),0)

This formula calculates the distance between each segment.  In column G, input the next
formula:

=IF(A1=A2, G1+E2,E2)

This formula sums the segment lengths and provides the total trace length for each fracture.  In
column I, input the following formula:

=IF(G2=G3,G2,0)

This formula nulls all values that are not the total length of the fracture.  Finally, in column K,
copy column I and paste the values (‘Paste Special’ values).  Save this file as a Microsoft Excel
workbook and name it 2200frac_coor.xls.

Create a new workbook and select columns A, B, C, and K in 2200frac_coor.xls.  Copy the
columns and paste thm in the new workbook.  Save the workbook as 2200length.xls.  Open the
files 2200strike.dbf and 2200dipxy.dbf.  Copy the respective strike and dip columns from the
.dbf files and paste them into 2200length.xls and save the workbook.

ENTRY 6.  CALCULATING FAULT DENSITY

In the file 2200length.xls, select all columns.  Under the ‘Data’ menu, choose ‘Filter’ and then
‘AutoFilter’.  Tabs should appear in the column titles.  Select the tab in the ‘length’ column and
select ‘Custom’.  A pop-up window will appear and choose ‘does not equal’ and type 0 in the
next column.  Click ‘OK’.

This filtering process filters out the null values (0) in the length column and only displays rows
that have the total trace length value.  In the ‘Data’ menu, select ‘Sort’ and then sort descending
in the XCOORD column.

In a separate column, sum the total trace length for 10m intervals, using the =SUM() function. 
Next to the sum column, calculate the fault density by dividing the total trace length column by
unit area (interval * circumference or 10*14.3).  It is important to note, that is process only
provides correct densities if the worksheet is filtered and sorted properly.

**Note: This process can be repeated for every 100m interval for the ECRB.  The only
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difference is the number attached to the file names and formulas. For example, files in the 
interval from 1000m-1100m would be named ‘1000all.shp’. For formulas used in ArcGIS, the 
first two numbers of the station need to be changed (ie. the formula would read: “Text” = 
‘XNDX1030$0$FEND’ and so forth). 

ENTRY 7: EXPORTING DATA FROM THE ESF 

Exporting data from the ESF follows the same procedure as above except that none of the .dxf 
files provided for the ESF will open in TurboCAD v10.2. Therefore, the process should begin at 
the ‘EXTRACTING STRIKE AND DIP DATA’ section. 

/ 
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December 29, 2004       DYW          

VERIFYING STOCHASTIC FRACTURE GENERATION STATISTICS VERSUS BOX REGION
USING FRACMAN

A series of simulations were performed using FracMan (Dershowitz and Herda, 1992; Golder
Associates Inc., 1998, 2002) to determine if the fracture sets generated within various region
boxes were consistent.  Refer to the Software Validation Testing for FracMan version 2.6 for
simulations performed to assess the statistical calculations of the software.  This testing was
done to determine if the software accounted for region geometric shape when generating
fracture sets.  Specifically, given a set number of fractures in a given volume, does the shape of
the box region affect the fractures statistics of P32 and fracture length?

TEST DESIGN

To determine what effect, if any, region shape had on fracture intensity values, four region
boxes were created.  These boxes have the same total volume, but comprised of a cube, a
vertical tabular box, a rod shaped box, and a horizontal tabular box.  The fracture set definitions
(e.g., fracture orientation, size) remained constant for all for boxes.  The number of fractures
generated with a given size in a given volume was also constant for all tests.  After fracture
generation, three traceplane were created to sample fracture data.  These traceplanes were
placed orthogonal to each other and situated well within each box in order to avoid sampling
outside the fracture generation region.  The statistics from the traceplanes were then compared
from the series of tests to determine if values were within the testing parameters described in
the Software Validation Test.

Region box dimensions:
Box 1: 20 m x 20 m x 20 m = 8000m3

Box 2: 10 m x 40 m x 20 m = 8000m3

Box 3: 80 m x 10 m x 10 m = 8000m3

Box 4: 32 m x 10 m x 25 m = 8000m3

Fracture set definitions:
Generation region = standard, Box 1
Clipping region = standard, Box 1
Generation model = Enhanced Baecher
Fracture intensity = measure by number of fractures
Parameters = 100 fractures
Fracture orientation: Fisher distribution, trend = 10, plunge = 45, dispersion = 100
Orientation specified by = Pole
Fracture size = Constant, parameter = 2
Fracture shape = 6 sides
Transmissivity = Constant
Storativity = Constant 
Aperture = Constant
Termination percentage = 0

Traceplane definitions:

A FracMan *.SAB file was created using the following parameters:
BEGIN COORDinate_system
    XAxis = East
END
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BEGIN traceplane
    name = "Traceplane 1"
    origin = -5 0 0
    scan_trend = 90
    scan_plunge = 0
    scan_length = 10
    tran_trend = 90
    tran_plunge = 90
    tran_width = 10
END

BEGIN traceplane
    name = "Traceplane 2"
    origin = 0 -5 0
    scan_trend = 0
    scan_plunge = 0
    scan_length = 10
    tran_trend = 0
    tran_plunge = 90
    tran_width = 10
END

BEGIN traceplane
    name = "Traceplane 3"
    origin = -5 0 0
    scan_trend = 90
    scan_plunge = 0
    scan_length = 10
    tran_trend = 0
    tran_plunge = 0
    tran_width = 10
END

TEST IMPLEMENTATION

Two complete tests were run using the stochastic generation of fractures defined from the
parameters above.  Refer to the Software Validation Test or Golder Associates Inc. (1998,
2002) for complete instruction on generating synthetic fracture populations in FracMan.  After
generation of the fracture set, the traceplanes were imported using the File ->Import->SAB file. 
Select the *.sab ASCII file with the parameters described above.  Select Analysis->Statistics. 
This generatee a series of fracture set statistics, including fracture density (P32).  For statistics
on specific traceplanes, select Analysis->Exploration->Traceplane.  Select a traceplane (e.g.,
Traceplane 1) and the Fracture Set Definition (there was only one fracture set for this test). 
This generated fracture statistics along the traceplane, including the number of intersecting
fractures and total trace length.  The statistical analysis was repeated for all three traceplanes. 
The information was then exported by right clicking inside the statistics window and selecting
Save to File.  This exports an ASCII file that can be read by Excel.  The entire procedure was
then repeated for the remaining box regions.

TEST RESULTS
The following table summarizes the testing for all box shapes.  The variation noted in the
traceplane analyses falls within acceptable ranges based on the Software Validation Test
parameters.  This should provide confidence that the geometric shape of a synthetic fracture
population (i.e., the thickness of a horizon) will not produce anomalous fracture statistics.  The
orientation and size of the sampling traceplane should be such that it will capture a true sample
of the fracture populations.
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Test 1
Box 1

dimensions
Box 2

dimensions
Box 3

dimensions
Box 4

dimensions
20x20x20 10x40x20 80x10x10 32x10x25

Traceplane 1     
 Box 1 Box 2 Box 3 Box 4
# of fractures 3 3 2 7
Total trace
length 4.4366 5.31131 2.62638 17.163
Avg trace
length 1.478866667 1.770436667 1.31319 2.451857143
     

    
Traceplane 2     
 Box 1 Box 2 Box 3 Box 4
# of fractures 5 7 6 7
Total trace
length 6.6462 12.9001 16.7712 15.2861
Avg trace
length 1.32924 1.842871429 2.7952 2.183728571
     

    
Traceplane 3     
 Box 1 Box 2 Box 3 Box 4
# of fractures 4 4 3 3
Total trace
length 5.72149 9.71143 8.77145 9.11309
Avg trace
length 1.4303725 2.4278575 2.923816667 3.037696667
     

Test 2
Box 1

dimensions
Box 2

dimensions
Box 3

dimensions
Box 4

dimensions
20x20x20 10x40x20 80x10x10 32x10x25

P32 value 0.144082 0.137031 0.138266 0.146887
Traceplane 1     
 Box 1 Box 2 Box 3 Box 4
# of fractures 6 5 3 4
Total trace
length 14.9033 14.6528 8.17856 11.5532
Avg trace
length 2.483883333 2.93056 2.726186667 2.8883
     

    
Traceplane 2     
 Box 1 Box 2 Box 3 Box 4
# of fractures 10 7 6 10
Total trace
length 23.9936 13.6946 16.062 24.5456
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February 4, 2005       DYW          

EXPLANATION OF ASCII CONVERSION FORMULA
Testing to verify DOE input values for FracMan requires comparisons of orientation data both in
Fracman and in Rockware StereoStat software.  A small unix conversion code was written by N.
Franklin to re-format the FracMan *.fab files to *.txt files for use in SteroeStat.  The following is a
detail of that code (fab2planes.awk).

#!/bin/sh
#
# ---------------------------------------------------------------------------
#   fab2planes.awk
#   abstract:   routine will change a fab file into a txt file of the planes 
# (strike, dip) and the radius of the fracture 
#
#   revised:   
#   created: Feb-2003
#
#                    Nathan Franklin / #20
#                    6220 culebra road
#                    san antonio tx 78238 usa
#                    E-mail: nfranklin@swri.edu
#                    Phone: 210-522-5207
# --------------------------------------------------------------------------- 

if ( test $# -ne '2' ) then
    echo Usage: $0 "<infile.fab>" "<outfile.txt>"
    exit
fi

if ( test ! -f $1 ) then
    echo File: $1 not found.
    exit
fi

nawk ' BEGIN {
garbage = ".garbage"
bool bBeginFracture;
bBeginFracture = 0;
int fracNumber;
int totalFracNumber;
int nFractures;
int readFractures;
fracNumber = 0;
readFractures = 0;
totalFracNumber = -2;
lineNumber = 0;
double radius
double x[7]; double y[7]; double z[7];
int vertexNumber;

}
{

if(lineNumber==0)
print "#strike dip trend plunge radius" > output

lineNumber++;
if(bBeginFracture==0) {

if( $1 == "No_Fractures" ) {
nFractures = $3;
print "reading .. " nFractures  " read"

}

if( substr($0,1,14) == "BEGIN FRACTURE" ) {
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bBeginFracture = 1;
}
if( substr($0,1,14) == "BEGIN Fracture" ) {

bBeginFracture = 1;
}

}
else if(bBeginFracture==1){

if( substr($0,1,12) == "END FRACTURE" ) {
bBeginFracture=0;

}
else if(fracNumber<=totalFracNumber  ){

if(NF!=4){
print "fracNumber=" fracNumber
print "ERROR on line " lineNumber;
print "NF = " NF;
print "bBeginFracture =" bBeginFracture;
exit;

}
else{

#print $2 " " $3 " " $4 > output
int vertexNumber;
vertexNumber = $1;
x[vertexNumber] = $2;
y[vertexNumber] = $3;
z[vertexNumber] = $4;
if(vertexNumber == totalFracNumber){

# Calculate  true normals
   double deltBAx;
   double deltBAy;
   double deltBAz;
   deltBAx = x[2] - x[1]
   deltBAy = y[2] - y[1]
   deltBAz = z[2] - z[1]

   double deltCAx;
   double deltCAy;
   double deltCAz;
   deltCAx = x[3] - x[1]
   deltCAy = y[3] - y[1]
   deltCAz = z[3] - z[1]

   # Face normal components i j k
double i; double j; double k;
i=0.0;
j=0.0;
k=0.0;

   i = (deltBAy *deltCAz) - (deltBAz * deltCAy);
   j = -1 * (deltBAx * deltCAz - deltBAz *

deltCAx);
   k = (deltBAx  *deltCAy) - (deltBAy *

deltCAx);

   #make all the normal point towards the lower
hemisphere

   if(k>0){
      i *= -1;
      j *= -1;
      k *= -1;
   }

#normalize all the normal vector
size = sqrt((i*i)+ (j*j) + (k*k));
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i = i /size; 
j = j /size; 
k = k /size; 

DTR = 0.0174532925;
trend =  atan2(i,j) /DTR;
if(trend < 0.0)

trend = trend + 360.0;
if(trend >= 360.0)

trend = trend - 360.0;

int sqroot;
sqroot = (i*i) + (j*j);
sqroot = sqrt(sqroot);

plunge = 90 - atan2(k,sqroot)/ DTR;
if(plunge > 90)

plunge = 180- plunge;
plunge = plunge - 90;

strike = trend + 90;
if(strike >= 360)

strike = strike - 360.0;

dip = 90 + plunge;

plunge = -1 * plunge;

print strike " " dip " " trend " " plunge
" " radius  > output

readFractures++;
}

}
}
else if($1==0){
}
else{

fracNumber=0;
totalFracNumber=$2;
radius=$7;
radius = radius + 0.0

}
fracNumber++;

   }
}
END {

print "   read " readFractures " fractures"
    } ' output=$2 < $1
exit
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GS971108314224.026. Revision 1 of Detailed Line Survey Data, Station 45+00 to
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Appendix 1 : Installation/Acceptance Test Memo for TurboCAD Deluxe (version 10.2) 

CENTER FOR NUCLEAR WASTE REGULATORY ANALYSES 

M E M O R A N D U M  

November 8.2004 
TO: Robert Brient, Director 

Quality Assurance 

Kevin J. Smart, Research Scientist 
Geology & Geophysics 

Acceptancellnstallation Test for TuhoCAF Deluxe (version 10.2) 

FROM: 

SUBJECT: 

TuhoCAP Deluxe (version 10.2) is marketed by IMSI, Inc., Novato. California and according to 
TOP-018 is classified as "Acquired Software -- Not To Be Modified." T u h o C A b  was developed 
to provide a user-friendly computer aided design (CAD) tool. 

JuhoCAf l  runs on all IBM PC-compatible computers (Windows 98/2000/NT 4.0/XP). It requires 
minimum of 64 MB of RAM, 55 to 212 MB hard disk space, and a Super VGA (1024x768) display. 
Currently, T u h o C A P  is installed on "Petrel" in the GIS lab (A251). The installation was conducted 
by a member of the IMS staff. 

The standard TuhoCAP installation provides thirtytwo 2D sample filesand eleven 3D sample files 
that illustrate the capabilities of the software. All sample files were successfully opened into 
TuhoCAD? HTML-format help files are included with the standard installation. 

At this time, I therefore recommend that TurboCAb Deluxe (version 10.2) be considered to have 
successfully passed the acceptancelinstallation test requirements. If you have any questions, 
please do not hesitate to contact me. 
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Entries into Scientific Notebook No. 685E for the period 1 1/08/04 to 3/24/05 (pp. 1-1 9) 
have been made by K.J. Smart, P. Landis, and D. Wyrick. No original text entered into 
this Scientific Notebook has been removed. 

I have reviewed this Scientific Notebook and find it in agreement with QAP-001. There 
is sufficient information regarding methods used for conducting tests, acquiring and 
analyzing data so that another qualified individual could repeat this activity. 
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UPDATED SUMMARY OF FRACTURE STATISTICS

The following section updates and supercedes statistical analyses of DOE-collected fracture
data that were originally documented by K.J. Smart in Scientific Notebook 606E.  This update
reflects a more complete analysis of fracture characteristics (e.g., orientation, spacing,
tracelength) based upon fracture sets that were defined on the basis of stratigraphic interval and
fracture orientation.

Table 1.  Summary of fracture data from Topopah Spring middle nonlithophysal zone (Tptpmn)
(excluding intensely fractured zone) based upon detailed line surveys in the ESF and ECRB,
and calculations by K.J. Smart. This data was collected with a lower tracelength cut-off of 1
meter (i.e., sampled fractures with tracelengths >1 meter). True spacing reflects correction of
orientation bias using a truncated Terzaghi approach (i.e., Terzaghi, 1965). Median intensity is
the inverse of median fracture spacing (equivalent to number of fractures per unit length of
scanline).  

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Tracelength

(m)

True
Spacing

(m)
Median

Intensity
(m-1)Mean Median Mean Median

All 6824, 100% n.a. n.a. 2.19 1.54 n.a. n.a. n.a.
1 3928, 58% 125°/85° 14.451 2.24 1.66 0.55 0.30 3.38
2 1835, 27% 217°/85° 4.684 1.97 1.40 0.81 0.37 2.73
3 545, 8% 327°/09° 29.131 2.68 1.64 0.96 0.49 2.02

Random 516, 8% n.a. n.a. 2.05 1.23 n.a. n.a. n.a.

Table 2.  Summary of fracture data from Topopah Spring middle nonlithophysal zone (Tptpmn)
(including intensely fractured zone) based upon detailed line surveys in the ESF and ECRB, and
calculations by K.J. Smart. This data was collected with a lower tracelength cut-off of 1 meter
(i.e., sampled fractures with tracelengths >1 meter). True spacing reflects correction of
orientation bias using a truncated Terzaghi approach (i.e., Terzaghi, 1965). Median intensity is
the inverse of median fracture spacing (equivalent to number of fractures per unit length of
scanline).  

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Tracelength

(m)

True
Spacing

(m)
Median

Intensity
(m-1)Mean Median Mean Median

All 11387, 100% n.a. n.a. 2.19 1.66 n.a. n.a. n.a.
1 7767, 68% 128°/84° 19.617 2.24 1.78 0.48 0.18 5.57
2 2397, 21% 221°/85° 5.463 1.97 1.45 1.27 0.43 2.30
3 599, 5% 327°/09° 28.081 2.54 1.55 1.04 0.50 2.02

Random 624, 5% n.a. n.a. 1.99 1.24 n.a. n.a. n.a.
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Table 3.  Summary of small-scale fracture data from Topopah Spring middle nonlithophysal
zone (Tptpmn) based on two six-meter horizontal and six 2-meter vertical scanlines in the
ECRB, and calculations by K.J. Smart. This data was collected with an upper tracelength cut-off
of 1 meter  (i.e., sampled fractures with tracelengths <1 meter). True spacing reflects correction
of orientation bias using a truncated Terzaghi approach (i.e., Terzaghi, 1965). Median intensity
is the inverse of median fracture spacing (equivalent to number of fractures per unit length of
scanline). 

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Tracelength

(m)

True
Spacing

(m)
Median

Intensity
(m-1)Mean Median Mean Median

All 391, 100% n.a. n.a. 0.63 0.20 n.a. n.a. n.a.
1a 55, 14% 132°/87° 94.768 1.22 0.43 0.24 0.10 10.08
1b 59, 15% 100°/85° 21.741 0.97 0.30 0.19 0.09 10.75
2a 68, 17% 159°/87° 52.630 0.38 0.13 0.16 0.08 11.83
2b 47, 12% 179°/88° 1.643 0.24 0.14  0.19 0.08 13.05
2c 53, 14% 202°/88° 51.361 0.49 0.27 0.11 0.05 20.02
3 54, 14% 312°/05° 42.197 0.76 0.31 0.19 0.12 8.37

Random 55, 14% n.a. n.a. 0.33 0.17 n.a. n.a. n.a.

Table 4.  Summary of fracture data from Topopah Spring lower lithophysal zone (Tptpll) based
upon detailed line surveys in the ESF and ECRB, and calculations by K.J. Smart. This data was
collected with a lower tracelength cut-off of 1 meter (i.e., sampled fractures with tracelengths >1
meter). True spacing reflects correction of orientation bias using a truncated Terzaghi approach
(i.e., Terzaghi, 1965). Median intensity is the inverse of median fracture spacing (equivalent to
number of fractures per unit length of scanline).  

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Tracelength

(m)

True
Spacing

(m)
Median

Intensity
(m-1)Mean Median Mean Median

All 338, 100% n.a. n.a. 4.04 1.92 n.a. n.a. n.a.
1 200, 59% 151°/82° 7.814 4.25 1.82 4.55 1.48 0.68
2a 47, 14% 205°/86° 26.076 3.82 1.90 8.18 4.09 0.24
2b 52, 15% 092°/85° 29.508 2.19 1.50 11.83 6.77 0.15
3 19, 6% 329°/05° 53.085 7.36 3.42 8.98 1.68 0.60

Random 20, 6% n.a. n.a. 4.88 2.78 n.a. n.a. n.a.



Scientific Notebook 685E Date Printed: 4/27/11

23

June 16, 2005       KJS          

Table 5.  Summary of small-scale fracture data from the Topopah Spring lower lithophysal zone
(Tptpll) based on three six-meter horizontal and nine 2-meter vertical scanlines in the ECRB,
and calculations by K.J. Smart. This data was collected with an upper tracelength cut-off of 1
meter (i.e., sampled fractures with tracelengths <1 meter). True spacing reflects correction of
orientation bias using a truncated Terzaghi approach (i.e., Terzaghi, 1965). Median intensity is
the inverse of median fracture spacing (equivalent to number of fractures per unit length of
scanline). 

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Tracelength

(m)

True
Spacing

(m)
Median

Intensity
(m-1)Mean Median Mean Median

All 649, 100% n.a. n.a. 0.31 0.16 n.a. n.a. n.a.
1 330, 51% 147°/84° 4.871 0.25 0.17 0.07 0.04 25.35
2a 30, 5% 202°/87° 33.034 0.22 0.19 0.36 0.17 6.75
2b 43, 7% 088°/85° 28.281 0.19 0.16 0.32 0.16 6.46
3 125, 19% 313°/04° 47.359 0.63 0.19 0.10 0.06 16.71

Random 121, 19% n.a. n.a. 0.20 0.13 n.a. n.a. n.a.

Table 6.  Summary of fracture data from Topopah Spring lower nonlithophysal zone (Tptpln)
based upon detailed line surveys in the ECRB, and calculations by K.J. Smart. This data was
collected with a lower tracelength cut-off of 1 meter (i.e., sampled fractures with tracelengths >1
meter). True spacing reflects correction of orientation bias using a truncated Terzaghi approach
(i.e., Terzaghi, 1965). Median intensity is the inverse of median fracture spacing (equivalent to
number of fractures per unit length of scanline).

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Tracelength

(m)

True
Spacing

(m)
Median

Intensity
(m-1)Mean Median Mean Median

All 199, 100% n.a. n.a. 4.04 1.93 n.a. n.a. n.a.
1a 96, 48% 134°/80° 48.804 3.85 2.06 2.18 0.75 1.33
2a 60, 30% 209°/85° 18.362 4.42 1.86 2.25 1.04 0.96
2b 22, 11% 170°/82° 9.091 5.70 2.28  9.18 5.52 0.18
3 16, 8% 337°/15° 67.639 1.55 1.31 2.75 1.59 0.63

Random 5, 3% n.a. n.a. 4.02 1.85 n.a. n.a. n.a.
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Table 7. Summary of fracture data from Topopah Spring upper lithophysal zone (Tptpul) based 
upon detailed line surveys in the ECRB and ESF, and calculations by K.J. Smart. This data was 
collected with a lower tracelength cut-off of 1 meter (Le., sampled fractures with tracelengths >I 
meter). True spacing reflects correction of orientation bias using a truncated Terzaghi approach 
(Le., Terzaghi, 1965). Median intensity is the inverse of median fracture spacing (equivalent to 
number of fractures per unit length of scanline). 

Total True 
Tracelength Spacing Median 

Intensity 
Number Fisher 

(m-'1 (m) (m) 
Mean dispersion Orientation coefficient 

Set 
Percentage Mean Median Mean Median 

All 1578, 100% n.a. n. a. 2.61 1.36 n. a. n. a. n. a. 
l a  258, 16% 121"/87" 26.134 2.20 1.44 3.38 1.17 0.85 
2a 946,60% 186"/85" 1.469 2.23 1.25 1.62 0.53 1.87 
2b 138, 9% 31 1 "/40° 2.333 5.75 3.30 4.10 2.21 0.45 
3 62,4% 329"/12" 19.716 5.43 3.88 3.53 1.20 0.83 

Random 174, 3% n. a. n. a. 1.80 1.18 n.a. n. a. n. a. 

Note: Set 2b has an intermediate dip of 40". 
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Figure 1.  Summary of orientation data for fractures from the Tptpmn (excluding intensely
fractured zone) collected via DLS in the ECRB and ESF using a lower tracelength cut-off of 1
meter.  Refer to table 1 for full data details.
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Figure 2.  Summary of orientation data for fractures from the Tptpmn (excluding intensely
fractured zone) collected via DLS in the ECRB and ESF using a lower tracelength cut-off of 1
meter.  Refer to table 2 for full data details.
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Figure 3.  Summary of orientation data for small-scale fractures (upper tracelength cut-off of 1
meter) from Tptpmn collected via two 6-meter horizontal and six 2-meter vertical scanlines in
the ECRB. Refer to table 3 for full data details.
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Figure 4.  Summary of orientation data for fractures from the Tptpll zone collected via DLS in
the ECRB and ESF using a lower tracelength cut-off of 1 meter.  Refer to table 4 for full data
details.
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Figure 5.  Summary of orientation data for small-scale fractures (upper tracelength cut-off of 1
meter) from Tptpll collected via three 6-meter horizontal and nine2-meter vertical scanlines in
the ECRB.  Refer to table 5 for full data details.
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Figure 6.  Summary of orientation data for fractures from the Tptpln zone collected via DLS in
the ECRB using a lower tracelength cut-off of 1 meter.  Refer to table 6 for full data details.
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Figure 7.  Summary of orientation data for fractures from the Tptpul zone collected via DLS in
the ECRB and ESF using a lower tracelength cut-off of 1 meter.  Refer to table 7 for full data
details.
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REVISED SUMMARY OF FRACTURE STATISTICS

The following section revises and supercedes previous statistical analyses of DOE-collected
fracture data.  This update incorporates additional DOE fracture data files discovered during
preparation of Intermediate Milestone IM 06002.01.292.510.

Table 1.  Summary of fracture data from Topopah Spring Tuff Upper Lithophysal zone based upon
detailed line surveys in the ECRB Cross-Drift and ESF. This data was collected with a lower trace length
cut-off of 1 m [3.3 ft] (i.e., sampled fractures with trace lengths >1 m [3.3 ft]). True spacing reflects
correction of orientation bias using a truncated Terzaghi approach (i.e., Terzaghi, 1965). Median intensity
is the inverse of median fracture spacing (equivalent to number of fractures per unit length of scanline). 

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Trace Length,

m [ft]

True
Spacing,

m [ft]
Median

Intensity,
m-1 [ft-1]Mean Median Mean Median

All 1758, 100% n.a. n.a. 2.56
[8.40]

1.42
[4.66] n.a. n.a. n.a.

1 538, 31% 116°/85° 7.462 2.09
[6.86]

1.44
[4.72]

2.82
[9.25]

0.75
[2.46]

1.34
[0.41]

2 1024, 58% 181°/85° 1.945 2.29
[7.51]

1.30
[4.66]

1.73
[5.68]

0.65
[2.13]

1.53
[0.47]

3 95, 5% 320°/19° 9.436 5.73
[18.80]

4.31
[14.14]

3.98
[13.06]

1.29
[4.23]

0.77
[0.23]

Random 101, 6% n.a. n.a. 4.87
[15.98]

2.10
[6.89] n.a. n.a. n.a.

Table 2.  Summary of fracture data from Topopah Spring Tuff Middle Nonlithophysal zone (including
intensely fractured zone) based upon detailed line surveys in the ESF and ECRB Cross-Drift. This data
was collected with a lower trace length cut-off of 1 m [3.3 ft]. True spacing reflects correction of orientation
bias using a truncated Terzaghi approach (i.e., Terzaghi, 1965). Median intensity is the inverse of median
fracture spacing (equivalent to number of fractures per unit length of scanline).  

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Trace Length,

m [ft]

True
Spacing,

m [ft]
Median

Intensity,
m-1 [ft-1]Mean Median Mean Median

All 13493, 100% n.a. n.a. 2.12
[6.96]

1.58
[5.18] n.a. n.a. n.a.

1 8919, 66% 126°/84° 17.670 2.18
[7.15]

1.70
[5.58]

0.42
[1.39]

0.19
[0.62]

5.20
[1.58]

2 2973, 22% 227°/86° 5.329 1.90
[6.23]

1.35
[4.43]

0.92
[3.02]

0.46
[1.51]

2.19
[0.67]

3 679, 5% 326°/08° 27.225 2.47
[8.10]

1.54
[5.05]

1.19
[3.90]

0.52
[1.71]

1.92
[0.59]

Random 922, 7% n.a. n.a. 2.02
[6.63]

1.27
[4.17] n.a. n.a. n.a.
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Table 3.  Summary of fracture data from the intensely fractured zone in the Topopah Spring Tuff Middle
Nonlithophysal zone based upon detailed line surveys in the ESF. This data was collected with a lower
trace length cut-off of 1 m [3.3 ft]. True spacing reflects correction of orientation bias using a truncated
Terzaghi approach (i.e., Terzaghi, 1965). Median intensity is the inverse of median fracture spacing
(equivalent to number of fractures per unit length of scanline).  

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Trace Length,

m [ft]

True
Spacing,

m [ft]
Median

Intensity,
m-1 [ft-1]Mean Median Mean Median

All 4566, 100% n.a. n.a. 2.18
[7.15]

1.80
[5.91] n.a. n.a. n.a.

1 3875, 85% 129°/84° 29.093 2.23
[7.32]

1.85
[6.07]

0.20
[0.66]

0.12
[0.39]

8.27
[2.52]

2 525, 11% 231°/87° 7.943 2.04
[6.69]

1.57
[5.15]

1.34
[4.40]

0.74
[2.43]

1.35
[0.41]

3 54, 1% 340°/07° 20.711 1.21
[3.97]

0.96
[3.15]

2.08
[6.82]

0.43
[1.41]

2.32
[0.71]

Random 112, 2% n.a. n.a. 1.73
[5.68]

1.37
[4.49] n.a. n.a. n.a.

Table 4.  Summary of fracture data from Topopah Spring Tuff Middle Nonlithophysal zone (excluding intensely
fractured zone) based upon detailed line surveys in the ESF and ECRB Cross-Drift. This data was collected
with a lower trace length cut-off of 1 m [3.3 ft]. True spacing reflects correction of orientation bias using a
truncated Terzaghi approach (i.e., Terzaghi, 1965). Median intensity is the inverse of median fracture spacing
(equivalent to number of fractures per unit length of scanline).  

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Trace Length,

m [ft]

True
Spacing,

m [ft]
Median

Intensity,
m-1 [ft-1]Mean Median Mean Median

All 8927, 100% n.a. n.a. 2.09
[6.86]

1.43
[4.69] n.a. n.a. n.a.

1 5044, 57% 124°/85° 13.814 2.14
[7.02]

1.52
[4.99]

0.59
[1.94]

0.28
[0.92]

3.54
[1.08]

2 2448, 27% 226°/86° 4.994 1.87
[6.14]

1.30
[4.27]

0.84
[2.76]

0.41
[1.35]

2.41
[0.73]

3 625, 7% 326°/08° 27.979 2.58
[8.46]

1.61
[5.28]

1.09
[3.58]

0.53
[1.74]

1.89
[0.58]

Random 810, 9% n.a. n.a. 2.07
[6.79]

1.27
[4.17] n.a. n.a. n.a.
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Table 5.  Summary of small-scale fracture data from Topopah Spring Tuff Middle Nonlithophysal zone based
on two 6-meter [20 ft] horizontal and six 2-meter [7 ft] vertical scanlines in the ECRB Cross-Drift. This data
was collected with an upper trace length cut-off of 1 m [3.3 ft]. True spacing reflects correction of orientation
bias using a truncated Terzaghi approach (i.e., Terzaghi, 1965). Median intensity is the inverse of median
fracture spacing (equivalent to number of fractures per unit length of scanline). 

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Trace Length,

m [ft]

True
Spacing,

m [ft]
Median

Intensity,
m-1 [ft-1]Mean Median Mean Median

All 391, 100% n.a. n.a. 0.63
[2.07]

0.20
[0.66] n.a. n.a. n.a.

1 164, 42% 179°/88° 14.449 0.38
[1.25]

0.15
[0.49]

0.07
[0.23]

0.04
[0.13]

26.10
[7.95]

2 118, 30% 118°/86° 15.514 1.06
[3.48]

0.30
[0.98]

0.11
[0.36]

0.07
[0.23]

15.31
[4.67]

3 54, 14% 312°/05° 42.197 0.76
[2.49]

0.31
[1.02]

0.19
[0.62]

0.12
[0.39]

8.37
[2.55]

Random 55, 14% n.a. n.a. 0.33
[1.08]

0.17
[0.56] n.a. n.a. n.a.

Table 6.  Summary of fracture data from Topopah Spring Tuff Lower Lithophysal zone based upon detailed
line surveys in the ESF and ECRB Cross-Drift. This data was collected with a lower trace length cut-off of 1
m [3.3 ft]. True spacing reflects correction of orientation bias using a truncated Terzaghi approach (i.e.,
Terzaghi, 1965). Median intensity is the inverse of median fracture spacing (equivalent to number of fractures
per unit length of scanline).  

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Trace Length,

m [ft]

True
Spacing,

m [ft]
Median

Intensity,
m-1 [ft-1]Mean Median Mean Median

All 338, 100% n.a. n.a. 4.04
[13.26]

1.92
[6.30] n.a. n.a. n.a.

1 254, 75% 158°/81° 2.606 4.21
[13.81]

1.88
[6.19]

3.48
[11.42]

1.39
[4.56]

0.72
[0.22]

2 60, 18% 087°/85° 17.759 2.32
[7.61]

1.63
[5.35]

9.07
[29.76]

6.17
[20.24]

0.16
[0.05]

3 19, 6% 329°/05° 53.085 7.36
[24.15]

3.42
[11.22]

4.59
[15.06]

1.39
[4.56]

0.72
[0.22]

Random 5, 1% n.a. n.a. 3.16
[10.37]

3.55
[11.65] n.a. n.a. n.a.



Scientific Notebook 685E Date Printed: 4/27/11

36

August 15, 2005       KJS          

Table 7.  Summary of small-scale fracture data from the Topopah Spring Tuff Lower Lithophysal zone based
on three 6-meter [20 ft] horizontal and nine 2-meter [7 ft] vertical scanlines in the ECRB Cross-Drift. This data
was collected with an upper trace length cut-off of 1 m [3.3 ft]. True spacing reflects correction of orientation
bias using a truncated Terzaghi approach (i.e., Terzaghi, 1965). Median intensity is the inverse of median
fracture spacing (equivalent to number of fractures per unit length of scanline). 

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Trace Length,

m [ft]

True
Spacing,

m [ft]
Median

Intensity,
m-1 [ft-1]Mean Median Mean Median

All 649, 100% n.a. n.a. 0.31
[1.02]

0.16
[0.52] n.a. n.a. n.a.

1 421, 65% 134°/82° 3.344 0.25
[0.82]

0.17
[0.56]

1.08
[3.54]

0.03
[0.10]

27.56
[8.40]

2 49, 8% 079°/82° 14.633 0.19
[0.62]

0.14
[0.50]

0.24
[0.79]

0.12
[0.39]

8.39
[2.56]

3 125, 19% 313°/04° 47.359 0.63
[2.07]

0.19
[0.62]

0.10
[0.33]

0.06
[0.20]

16.71
[5.09]

Random 54, 8% n.a. n.a. 0.17
[0.56]

0.12
[0.39] n.a. n.a. n.a.

Table 8.  Summary of fracture data from Topopah Spring Tuff Lower Nonlithophysal zone based upon
detailed line surveys in the ECRB Cross-Drift. This data was collected with a lower trace length cut-off of 1
m [3.3 ft]. True spacing reflects correction of orientation bias using a truncated Terzaghi approach (i.e.,
Terzaghi, 1965). Median intensity is the inverse of median fracture spacing (equivalent to number of
fractures per unit length of scanline).

Set
Number

&
 Percentage

Mean
Orientation

Fisher
dispersion
coefficient

Total
Trace Length,

m [ft]

True
Spacing,

m [ft]
Median

Intensity,
m-1 [ft-1]Mean Median Mean Median

All 199, 100% n.a. n.a. 4.04
[13.26]

1.93
[6.33] n.a. n.a. n.a.

1 121, 61% 134°/80° 48.804 4.39
[14.40]

2.25
[7.38]

1.89
[6.20]

0.73
[2.40]

1.37
[0.42]

2 61, 31% 209°/85° 18.362 4.05
[13.29]

1.66
[5.45]

1.79
[5.87]

0.70
[2.30]

1.42
[0.43]

3 16, 8% 337°/15° 67.639 1.55
[5.09]

1.31
[4.30]

2.75
[9.02]

1.59
[5.22]

0.63
[0.19]

Random 1, <1% n.a. n.a. 1.85
[6.07]

1.85
[6.07] n.a. n.a. n.a.
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FRACMAN MODEL RUNS FOR Tptpll

Two sets of models were performed for the Tptpll.  These model runs were named
ll_FM_DOE_input_test1-random.fwk, using a randomly generated seed number, and
ll_FM_DOE_input_test2-seed725.fwk, using the DOE provided seed number of 725.  Within the
FracMan software, a model was setup using the parameters specified in Figure B-3 of the Drift
Degradation Analysis (ANL-EBS-MD-000027 REV03).  Six distinct fracture sets were input into
the models and various tests were performed.

VERIFICATION OF ORIENTATION AND DISPERSION OF FRACTURES

The FracMan generated fractures were exported from FracMan as *.fab files (e.g.,
fracs_test1_set1.fab).  Using the shell script fab2planes.awk (detailed earlier in notebook), the
files were converted to *.txt.  These files were then imported into Rockware StereoStat and used
to calculate the fracture orientation and dispersion (k value).  The following values were derived
for tests 1 and 2:

StereoStat Results, Test 1
22jun05, dyw

FILE: fracs_test1_set1.txt
Average orientation: (azimuth, plunge) (238,76)
KValue: 72.95
FM INPUT VALUES: (239,76) K=70

FILE: fracs_test1_set2.txt
Average orientation: (azimuth, plunge) (040,10)
KValue: 69.294
FM INPUT VALUES: (040,10) K=70

FILE: fracs_test1_set3.txt
Average orientation: (azimuth, plunge) (076,10)
KValue: 63.442
FM INPUT VALUES: (085,10) K=70

FILE: fracs_test1_set4.txt
Average orientation: (azimuth, plunge) (040,10)
KValue: 99.104
FM INPUT VALUES: (040,10) K=100

FILE: fracs_test1_set5.txt
Average orientation: (azimuth, plunge) (080,10)
KValue: 100.84
FM INPUT VALUES: (085,10) K=100

FILE: fracs_test1_set6.txt
Average orientation: (azimuth, plunge) (008,05)
KValue: 102.25
FM INPUT VALUES: (008,05) K=100

StereoStat Results, Test 2
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FILE: fracs_test2_set1.txt
Average orientation: (azimuth, plunge) (238,76)
KValue: 72.95
FM INPUT VALUES: (239,76) K=70

FILE: fracs_test2_set2.txt
Average orientation: (azimuth, plunge) (040,10)
KValue: 69.294
FM INPUT VALUES: (040,10) K=70

FILE: fracs_test2_set3.txt
Average orientation: (azimuth, plunge) (077,10)
KValue: 68.625
FM INPUT VALUES: (085,10) K=70

FILE: fracs_test2_set4.txt
Average orientation: (azimuth, plunge) (040,10)
KValue: 100.16
FM INPUT VALUES: (040,10) K=100

FILE: fracs_test2_set5.txt
Average orientation: (azimuth, plunge) (081,10)
KValue: 99.334
FM INPUT VALUES: (085,10) K=100

FILE: fracs_test2_set6.txt
Average orientation: (azimuth, plunge) (008,05)
KValue: 104.13
FM INPUT VALUES: (008,05) K=100

All values were within the predefined range of acceptance.  There was a minor correction done
to the fracture dispersion values, due to the software’s inability to calculate dispersion values
within certain orientation ranges.  The following notes document the corrections made.

************************************************************************
StereoStat derived k values from fracs_test1_setX.fab/txt

These files are from synthetic fractures generated in FracMan using:
1) a random seed number (Test 1)
2) DOE seed #725 (Test 2), per figure B-3 of the Drift Degradation Analysis
 (ANL-EBS-MD-000027, REV03; Sept 2004)

The *.txt files were imported into StereoStat to derive fracture statistics.
************************************************************************
Currently the files fracs_test1_set3.txt and fracs_test1_set5.txt are
generating unusual statistics in the dispersion (k) value.  This may be due to
their orientation.  A series of tests should be performed, e.g. rotating the
entire data set around a vertical axis, to determine if this a real problem
with the data set or merely a bug in the software that can be worked around.
dyw
23jun05
************************************************************************
The same error has occurred for the fracs_test2_set3.txt and
fracs_test2_set5.txt. The most likely culprit is a glitch in the software that
is unable to calculate k values on this data set due to the orientation.



Scientific Notebook 685E Date Printed: 4/27/11

39

Further tests are currently being performed to constrain the problem.
dyw
24jun05
************************************************************************
The data set statistics can be generated by essentially running the data twice
-- once to derive orientation (azimuth data) and then rotating the entire data
set -45/ to derive k.  The software has a problem determining the k value for
this particular orientation.  The following statistics were generating using
this method.  The k value is used on the rotated data and the orientation is
used on the regular data.
dyw
28jun05

fracs_test1_set3.txt rotated
(40,10) k=63.442
fracs_test1_set3.txt 
(76,10) k=2.0438

fracs_test1_set5.txt rotated
(40,10) k=100.84
fracs_test1_set5.txt 
(80,10) k=2.6725

fracs_test2_set3.txt rotated
(40,10) k=68.625
fracs_test2_set3.txt 
(77,10) k=2.2051

fracs_test2_set5.txt rotated
(40,10) k=99.334
fracs_test2_set5.txt 
(81,10) k=2.9848
************************************************************************

NOTE: The software still has a software glitch, so a series of functions must be performed in
this order to get all the statistics:
1) Open StereoStat
2) Open *.txt file and assign column headers as normal
3) Plot Stereonet of data (Plot->Stereonet->Plot fault lineations only)
4) Close plot
5) Rotate data (Data->Rotate Data->Rotate entire dataset; Vertical axis; -45 deg)
6) Plot Stereonet of rotated data (see above)
7) Close plot
8) With rotated dataset selected, Analyze Data (Data Analysis->Analyze Data->Analyze Faults;
donot Add results to dataset; click Fisher axis Options; select Treat data as axes)
9) Repeat step 8 with the regular data set

BOREHOLE RESULTS TO DERIVE P10 FRACTURE DENSITY VALUES

A series of boreholes were “drilled” into the fracture model volume to derive fracture density
(P10, number of fractures per unit length).  The following SAB file was created and imported into
FracMan (9_boreholes_1m.SAB).  It creates nine evenly spaced boreholes with a length of 100
m and a radius of 1 m.  The boreholes are oriented with a trend and plunge to mimic the
orientation of the DLS data (071,00).  They are situated well within the defined model region to
avoid artificial cropping at the model edge.  

BEGIN borehole_simple
    name = "Borehole 1"
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    origin =       -45.000        -45.0        .000
    trend  =      71.000
    plunge =      0.000
    radius =        1.0
    length =     100
END

BEGIN borehole_simple
    name = "Borehole 2"
    origin =       -45.000        -25.0        .000
    trend  =      71.000
    plunge =      0.000
    radius =        1.0
    length =     100
END

BEGIN borehole_simple
    name = "Borehole 3"
    origin =       -45.000        -5.0        .000
    trend  =      71.000
    plunge =      0.000
    radius =        1.0
    length =     100
END

BEGIN borehole_simple
    name = "Borehole 4"
    origin =       -45.000        -45.0        20.000
    trend  =      71.000
    plunge =      0.000
    radius =        1.0
    length =     100
END

BEGIN borehole_simple
    name = "Borehole 5"
    origin =       -45.000        -25.0        20.000
    trend  =      71.000
    plunge =      0.000
    radius =        1.0
    length =     100
END

BEGIN borehole_simple
    name = "Borehole 6"
    origin =       -45.000        -5.0        20.000
    trend  =      71.000
    plunge =      0.000
    radius =        1.0
    length =     100
END

BEGIN borehole_simple
    name = "Borehole 7"
    origin =       -45.000        -45.0        -20.000
    trend  =      71.000
    plunge =      0.000
    radius =        1.0
    length =     100
END

BEGIN borehole_simple
    name = "Borehole 8"
    origin =       -45.000        -25.0        -20.000
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    trend  =      71.000
    plunge =      0.000
    radius =        1.0
    length =     100
END

BEGIN borehole_simple
    name = "Borehole 9"
    origin =       -45.000        -5.0        -20.000
    trend  =      71.000
    plunge =      0.000
    radius =        1.0
    length =     100
END

After importing the borehole SAB file into the FracMan model, select Analysis->Exploration-
>Borehole.  Borehole sampling was done on each individual fracture set and on the entire
model fracture sets.  Results are summarized in the supplemental files
BH_FM_DOE_fracs_test1-random_all-sets.xls and BH_FM_DOE_fracs_test2-seed725_all-
sets.xls.  The following corrections were made to the borehole results:

************************************************************************
BH_FM_DOE_fracs_test2-seed725_all-sets

The FracMan generation of 'seed725' fractures contains 6 sets of fractures.
Set 6 has a very small fracture density input value and small fracture radius.
When drilling exploration boreholes in the fracture set 6, none of the
boreholes encounters a fracture. As such, no statistics are being compiled by
the software. An export set6.sts file was not generated by FracMan.  Instead,
I have replicated the export file, substituting zeros for the Intensity P10
values, and filling in all other fracture data from information within the
FracMan project.
dyw
23jun05
************************************************************************

FRACTURE RADIUS DISTRIBUTION RESULTS

The exported fracture files (e.g., fracs_test1_set1.txt) were imported into Excel to plot frequency
versus fracture radius histogram plots.  The fracture size was binned in increments of 0.5 m and
plotted for each individual fracture set and the combined model fractures.  The results are
summarized in the supplemental files ll_FM_DOE_input_test1-random_all-sets.xls and
ll_FM_DOE_input_test2-seed725_all-sets.xls.

TUNNEL RESULTS TO DERIVE P21 FRACTURE DENSITY VALUES

A series of tunnels were “drilled” into the fracture model volume to derive fracture density (P20,
number of fractures per unit area and P21, total fracture length per unit area).  The following
SAB file was created and imported into FracMan (tunnel-5_90m.SAB).  It creates five tunnels
with a length of 90 m with a radius of 5.5 m. The tunnels consist of seven panels arranged in an
octagon shaped tunnel with the floor (the eight panel) deleted to closely mimic the FPGM data
sets.  The tunnels are evenly spaced throughout the model region and oriented with a trend and
plunge similar to the DLS data (071,00).  They are situated well within the defined region to
avoid artificial cropping at the model edge.

BEGIN COORDinate_system
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    XAxis = East
END

BEGIN traceplane
    name = "Tunnel_bottom_traceplane_1-90"
    origin = -45 -44.235 1.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = -45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_bottom_traceplane_2-90"
    origin = -45 -42.5 2.5425
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 0
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_bottom_traceplane_3-90"
    origin = -45 -40.765 1.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_bottom_traceplane_4-90"
    origin = -45 -40 0
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 90
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_bottom_traceplane_5-90"
    origin = -45 -40.765 -1.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = -45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_bottom_traceplane_6-90"
    origin = -45 -42.5 -2.5425
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
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    tran_trend = 0
    tran_plunge = 0
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_bottom_traceplane_7-90"
    origin = -45 -44.235 -1.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_center_traceplane_1"
    origin = -45 -24.235 1.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = -45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_center_traceplane_2"
    origin = -45 -22.5 2.5425
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 0
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_center_traceplane_3"
    origin = -45 -20.765 1.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_center_traceplane_4"
    origin = -45 -20 0
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 90
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_center_traceplane_5"
    origin = -45 -20.765 -1.7775
    scan_trend = 71
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    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = -45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_center_traceplane_6"
    origin = -45 -22.5 -2.5425
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 0
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_center_traceplane_7"
    origin = -45 -24.235 -1.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_top_traceplane_1"
    origin = -45 -4.235 1.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = -45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_top_traceplane_2"
    origin = -45 -2.5 2.5425
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 0
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_top_traceplane_3"
    origin = -45 -.765 1.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_top_traceplane_4"
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    origin = -45 0 0
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 90
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_top_traceplane_5"
    origin = -45 -.765 -1.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = -45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_top_traceplane_6"
    origin = -45 -2.5 -2.5425
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 0
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_top_traceplane_7"
    origin = -45 -4.235 -1.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_left_traceplane_1"
    origin = -45 -24.235 21.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = -45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_left_traceplane_2"
    origin = -45 -22.5 22.5425
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 0
    tran_width = 2.16
END
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BEGIN traceplane
    name = "Tunnel_left_traceplane_3"
    origin = -45 -20.765 21.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_left_traceplane_4"
    origin = -45 -20 20
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 90
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_left_traceplane_5"
    origin = -45 -20.765 18.2225
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = -45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_left_traceplane_6"
    origin = -45 -22.5 17.4575
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 0
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_left_traceplane_7"
    origin = -45 -24.235 18.2225
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_right_traceplane_1"
    origin = -45 -24.235 -18.2225
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = -45
    tran_width = 2.16
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END

BEGIN traceplane
    name = "Tunnel_right_traceplane_2"
    origin = -45 -22.5 -17.4575
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 0
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_right_traceplane_3"
    origin = -45 -20.765 -18.2225
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_right_traceplane_4"
    origin = -45 -20 -20
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 90
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_right_traceplane_5"
    origin = -45 -20.765 -21.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = -45
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_right_traceplane_6"
    origin = -45 -22.5 -22.5425
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
    tran_plunge = 0
    tran_width = 2.16
END

BEGIN traceplane
    name = "Tunnel_right_traceplane_7"
    origin = -45 -24.235 -21.7775
    scan_trend = 71
    scan_plunge = 0
    scan_length = 90
    tran_trend = 0
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    tran_plunge = 45
    tran_width = 2.16
END

Fracture tracelength data was extracted for each fracture set and the total fracture sets by
selecting Analysis->Exploration->Traceplane.  All seven traceplanes were highlighted that
constitute the tunnel.  The data was then imported into Excel and is summarized in the files
ll_Tunnels_all-frac-sets_test1-random.xls and ll_Tunnels_all-frac-sets_test2-seed725.xls.

Calculations performed in Excel versus FracMan had a small variance.  The following notes
document the discrepancy:

*********************************************************************
Tunnel traceplanes

There is a discrepancy between the area that FracMan calculates for the area
of a traceplane and hand calculations of the area. Specifically, the
traceplane is 2.16m wide and 90m long.  Visual checks all indicate that the
traceplane is well within the box region and is not being artificially
truncated by the box.  However, the program calculates the area differently
for each trace plane. There seems to be a correlation between the angle of the
transverse plunge and the area calculated.  Traceplanes with the same length,
width, trend *and* antithetical plunge values that are the same (e.g., one
plane dipping at 45/ and the other at -45/) have the same area calculated. 
This value however is slightly less than the area determined by hand
calculations (e.g., 2.16*90=194.4).  A traceplane with a transverse plunge of
90/ gives the most accurate area.

Will continue to pursue this matter.
dyw
01jul05
*********************************************************************
A series of calculations was performed to determine what effect, if any, the
small variance in the traceplane area would have on the overall fracture
density values.  When calculating P21 density, the small difference in area
from FracMan and Excel calculations amounts to a difference of less than
0.003.  This small amount is not sufficient in the fracture density analysis,
so the values derived from FracMan will be used as generated.
dyw
15jul05
*********************************************************************

FRACMAN MODEL RUNS FOR Tptpmn

Two sets of models were performed for the Tptpmn.  These model runs were named
mn_FM_DOE_input_test1-random.fwk, using a randomly generated seed number, and
mn_FM_DOE_input_test2-seed1.fwk, using the DOE provided seed number of 001.  Within the
FracMan software, a model was setup using the parameters specified in Figure 6-18 of the Drift
Degradation Analysis (ANL-EBS-MD-000027 REV03).  Seven distinct fracture sets were input
into the models and various tests were performed.  The tests were identical in nature to the
tests performed for the Tptpll unit and are summarized in the supplemental files.
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REVISED SUMMARY OF FRACTURE STATISTICS (continued from page 36)

Spreadsheets containing fracture data are listed in the following file (README.RTF) that is
included on the CD with the spreadsheets:

K.J. Smart
August 15, 2005

File listing for spreadsheets used for fracture synthesis report (IM
06002.01.292.510):

(1) DLS_Fracture-Type_PIE.xls --> Detailed line survey (DLS) data on fracture type as
recorded in ESF and ECRB.

(2) DLS_Tptpll.xls --> DLS data for Topopah Spring Tuff Lower Lithophysal zone as
recorded in ESF and ECRB.

(3) DLS_Tptpln.xls --> DLS data for Topopah Spring Tuff Lower Nonlithophysal zone as
recorded in ESF and ECRB.

(4) DLS_Tptpmn_All.xls --> DLS data for all fractures from Topopah Spring Tuff Middle
Nonlithophysal zone as recorded in ESF and ECRB.

(5) DLS_Tptpmn_IFZ-only.xls --> DLS data for intensely fractured zone (IFZ) from the
Topopah Spring Tuff Middle Nonlithophysal zone in the ESF.

(6) DLS_Tptpmn_wo-IFZ.xls --> DLS data for fractures (excluding the IFZ in the ESF)
from Topopah Spring Tuff Middle Nonlithophysal zone as recorded in ESF and ECRB.

(7) DLS_Tptpul.xls --> DLS data for Topopah Spring Tuff Upper Lithophysal zone as
recorded in ESF and ECRB.

(8) ECRB_DLS_Fractures_All.xls --> DLS data for all fractures recorded in the ECRB.

(9) ECRB_FPGM_Tptpll_orientations.xls --> Full-periphery geologic mapping (FPGM) data
for fracture orientations from the Topopah Spring Tuff Lower Lithophysal zone from
the ECRB.

(10) ECRB_FPGM_Tptpln_orientations.xls --> FPGM data for fracture orientations from
the Topopah Spring Tuff Lower Nonlithophysal zone from the ECRB.

(11) ECRB_FPGM_Tptpmn_orientations.xls --> Full-periphery geologic mapping (FPGM)
data for fracture orientations from the Topopah Spring Tuff Middle Nonlithophysal
zone from the ECRB.

(12) ECRB_FPGM_Tptpul_orientations.xls --> Full-periphery geologic mapping (FPGM)
data for fracture orientations from the Topopah Spring Tuff Upper Lithophysal zone
from the ECRB.

(13) ESF_DLS_Fractures_All.xls --> DLS data for all fractures recorded in the ESF.

(14) ESF_FPGM_Fractures_All.xls --> FPGM data for all fracture orientations from the
ESF.

(15) Small-Scale-Fracture-Data_Tptpll --> DLS data for small-scale fracture study in
the Topopah Spring Tuff Lower Lithophysal zone as recorded in ECRB.

(16) Small-Scale-Fracture-Data_Tptpmn --> DLS data for small-scale fracture study in
the Topopah Spring Tuff Middle Nonlithophysal zone as recorded in ECRB.
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Figure 1.  Distribution of fractures by type as recorded by detailed line survey in the (A) ESF and (B) the ECRB
Cross-Drift.

Figure 2.  Summary of fractures with recorded displacement based upon detailed line survey in the ESF.  (A)
Displacement versus cumulative percentage.  (B) Comparison of total trace length versus displacement.  (C) Equal-
area stereonet plot of fracture poles.  (D) Contours of poles to fracture planes calculated with the 1% area method

(Knopf and Ingerson, 1938; Turner and Weiss, 1963).
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Figure 3.  Summary of fractures with recorded displacement based upon detailed line survey in the ECRB Cross-
Drift.  (A) Displacement versus cumulative percentage.  (B) Comparison of total trace length versus displacement. 
(C) Equal-area stereonet plot of fracture poles.  (D) Contours of poles to fracture planes calculated with the Kamb

method (Kamb, 1959).  The Kamb contouring method was used because the 1% method is not appropriate for data
sets smaller than approximately 300 points.

Figure 4.  Orientation summary for fractures from the Topopah Spring Tuff Upper Lithophysal zone recorded by
detailed line survey in the ESF and the ECRB Cross-Drift.  (A) Equal-area stereonet plot of poles to fracture planes. 

(B) Contours of poles to fracture planes calculated with 1% area method.
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Figure 5.  Orientation summary for fractures from the Topopah Spring Tuff Middle Nonlithophysal zone (including the
intensely fractured zone) recorded by detailed line survey in the ESF and the ECRB Cross-Drift.  (A) Equal-area

stereonet plot of poles to fracture planes.  (B) Contours of poles to fracture planes calculated with 1% area method.

Figure 6.  Orientation summary for fractures from the intensely fractured zone within the Topopah Spring Tuff Middle
Nonlithophysal zone recorded by detailed line survey in the ESF (stations 42+00 to 51+50).  (A) Equal-area stereonet

plot of poles to fracture planes.  (B) Contours of poles to fracture planes calculated with 1% area method.
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Figure 7.  Orientation summary for fractures from the Topopah Spring Tuff Middle Nonlithophysal zone (excluding the
intensely fractured zone) recorded by detailed line survey in the ESF and the ECRB Cross-Drift.  (A) Equal-area

stereonet plot of poles to fracture planes.  (B) Contours of poles to fracture planes calculated with 1% area method.

Figure 8.  Orientation summary for small-scale fractures from the Topopah Spring Tuff Middle Nonlithophysal zone
recorded by detailed line survey in the ECRB Cross-Drift.  (A) Equal-area stereonet plot of poles to fracture planes. 

(B) Contours of poles to fracture planes calculated with 1% area method.
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Figure 9.  Orientation summary for fractures from the Topopah Spring Tuff Lower Lithophysal zone recorded by
detailed line survey in the ESF and the ECRB Cross-Drift.  (A) Equal-area stereonet plot of poles to fracture planes. 

(B) Contours of poles to fracture planes calculated with 1% area method. 

Figure 10.  Orientation summary for small-scale fractures from the Topopah Spring Tuff Lower Lithophysal zone
recorded by detailed line survey in the ECRB Cross-Drift.  (A) Equal-area stereonet plot of poles to fracture planes. 

(B) Contours of poles to fracture planes calculated with 1% area method.
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Figure 11.  Orientation summary for fractures from the Topopah Spring Tuff Lower Nonlithophysal zone recorded by
detailed line survey in the ECRB Cross-Drift.  (A) Equal-area stereonet plot of poles to fracture planes.  (B) Contours

of poles to fracture planes calculated with 1% area method.

Figure 12.  Orientation summary for all fractures recorded by full-periphery geologic mapping in the ESF.  (A) Equal-
area stereonet plot of poles to fracture planes.  (B) Contours of poles to fracture planes calculated with 1% area

method.
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Figure 13.  Orientation summary for fractures recorded by full-periphery geologic mapping in the ESF from the
Topopah Spring Tuff Upper Lithophysal, Middle Nonlithophysal, and Lower Lithophysal zones.  (A) Equal-area

stereonet plot of poles to fracture planes.  (B) Contours of poles to fracture planes calculated with 1% area method.

Figure 14.  Orientation summary for fractures recorded by full-periphery geologic mapping in the ESF from the
Topopah Spring Tuff Upper Lithophysal zone.  (A) Equal-area stereonet plot of poles to fracture planes.  (B) Contours

of poles to fracture planes calculated with 1% area method.
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Figure 15.  Orientation summary for fractures recorded by full-periphery geologic mapping in the ESF from the
Topopah Spring Tuff Middle Nonlithophysal zone.  (A) Equal-area stereonet plot of poles to fracture planes.  (B)

Contours of poles to fracture planes calculated with 1% area method.

Figure 16.  Orientation summary for fractures recorded by full-periphery geologic mapping in the ESF from the
Topopah Spring Tuff Lower Lithophysal zone.  (A) Equal-area stereonet plot of poles to fracture planes.  (B) Contours

of poles to fracture planes calculated with 1% area method.
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Figure 17.  Orientation summary for fractures recorded by full-periphery geologic mapping in the ECRB Cross-Drift. 
(A) Equal-area stereonet plot of poles to fracture planes.  (B) Contours of poles to fracture planes calculated with 1%

area method.

Figure 18.  Orientation summary for fractures from the Topopah Spring Tuff Upper Lithophysal zone recorded by full-
periphery geologic mapping in the ECRB Cross-Drift.  (A) Equal-area stereonet plot of poles to fracture planes.  (B)

Contours of poles to fracture planes calculated with 1% area method.
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Figure 19.  Orientation summary for fractures from the Topopah Spring Tuff Middle Nonlithophysal zone recorded by
full-periphery geologic mapping in the ECRB Cross-Drift.  (A) Equal-area stereonet plot of poles to fracture planes. 

(B) Contours of poles to fracture planes calculated with 1% area method.

Figure 20.  Orientation summary for fractures from the Topopah Spring Tuff Lower Lithophysal zone recorded by full-
periphery geologic mapping in the ECRB Cross-Drift.  (A) Equal-area stereonet plot of poles to fracture planes.  (B)

Contours of poles to fracture planes calculated with 1% area method.
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Figure 21.  Orientation summary for fractures from the Topopah Spring Tuff Lower Nonlithophysal zone recorded by
full-periphery geologic mapping in the ECRB Cross-Drift.  (A) Equal-area stereonet plot of poles to fracture planes. 

(B) Contours of poles to fracture planes calculated with 1% area method.

Figure 22.  Fracture trace length summary for FPGM data from ECRB Cross-Drift.  Total trace length for 10 m [33 ft]
and 100 m [328 ft] segments of the ECRB Cross-Drift as determined from full-periphery geologic mapping data. 

Abbreviations for Topopah Spring Tuff zones: Tptpul = Upper Lithophysal; Tptpmn = Middle Nonlithophysal; Tptpll =
Lower Lithophysal; Tptpln = Lower Nonlithophysal.
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Figure 23.  Fracture trace length summary for DLS data from ECRB Cross-Drift.  Total trace length for 10 m [33 ft]
and 100 m [328 ft] segments of the ECRB Cross-Drift as determined from detailed line survey data.  Abbreviations

are the same as shown in figure 22.

Figure 24.  Fracture density summary for FPGM data from ECRB Cross-Drift.  Total trace length per unit area (or P21)
averaged over 10 m [33 ft] and 100 m [328 ft] segments of  the ECRB Cross-Drift as determined from full-periphery

geologic mapping data.  Abbreviations are the same as shown in figure 22.
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Figure 25.  Fracture density contours superimposed over fracture traces from full-periphery geologic mapping in the
ECRB Cross-Drift for stations 1+00 to 5+00. Fracture density is calculated as total trace length per unit area (or P21)
within ArcGIS based upon a 5 m [16 ft] diameter search radius.  Abbreviations are the same as shown in figure 22.
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Figure 26.  Fracture density contours superimposed over fracture traces from full-periphery geologic mapping in the
ECRB Cross-Drift for stations 5+00 to 10+00. Fracture density is calculated as total trace length per unit area within

ArcGIS based upon a 5 m [16 ft] diameter search radius.  Abbreviations are the same as shown in figure 22.
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Figure 27.  Fracture density contours superimposed over fracture traces from full-periphery geologic mapping in the
ECRB Cross-Drift for stations 10+00 to 15+00. Fracture density is calculated as total trace length per unit area within

ArcGIS based upon a 5 m [16 ft] diameter search radius.  Abbreviations are the same as shown in figure 22.
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Figure 28.  Fracture density contours superimposed over fracture traces from full-periphery geologic mapping in the
ECRB Cross-Drift for stations 15+00 to 20+00. Fracture density is calculated as total trace length per unit area within

ArcGIS based upon a 5 m [16 ft] diameter search radius.  Abbreviations are the same as shown in figure 22.
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Figure 29.  Fracture density contours superimposed over fracture traces from full-periphery geologic mapping in the
ECRB Cross-Drift for stations 20+00 to 24+00. Fracture density is calculated as total trace length per unit area within

ArcGIS based upon a 5 m [16 ft]  diameter search radius.  Abbreviations are the same as shown in figure 22.
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Figure 30.  Fracture density contours superimposed over fracture traces from full-periphery geologic mapping in the
ECRB Cross-Drift for stations 24+00 to 26+60. Fracture density is calculated as total trace length per unit area within

ArcGIS based upon a 5 m [16 ft] diameter search radius.  Abbreviations are the same as shown in figure 22.
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Figure 32.  Orientation summary for synthetic fractures generated for the Topopah Spring Tuff Middle Nonlithophysal
zone (test 1).  (A) Equal-area stereonet plot of poles to fracture planes.  (B) Contours of poles to fracture planes

calculated with 1% area method.

Figure 33.  Orientation summary for synthetic fractures generated for the Topopah Spring Tuff Middle Nonlithophysal
zone (test 2).  (A) Equal-area stereonet plot of poles to fracture planes.  (B) Contours of poles to fracture planes

calculated with 1% area method.
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Figure 34.  Summary of synthetic fracture radius distributions for the Topopah Spring Tuff Middle Nonlithophysal
zone (test 1). (A) Set 1and 5 fractures are northwest-striking and subvertical. (B) Set 2 and 6 fractures are northeast-
striking and subvertical. (C) Set 3 and 7 fractures are northwest-striking with an intermediate dip to the northeast. (D)

Set 4 fractures are subhorizontal. 

Figure 35.  Summary of synthetic fracture radius distributions for the Topopah Spring Tuff Middle Nonlithophysal
zone (test 2). (A) Set 1 and 5 fractures are northwest-striking and subvertical. (B) Set 2 and 6 fractures are northeast-
striking and subvertical. (C) Set 3 and 7 fractures are northwest-striking with an intermediate dip to the northeast. (D)

Set 4 fractures are subhorizontal. 
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Figure 37.  Orientation summary for synthetic fractures generated for the Topopah Spring Tuff Lower Lithophysal
zone (test 1).  (A) Equal-area stereonet plot of poles to fracture planes.  (B) Contours of poles to fracture planes

calculated with 1% area method.

Figure 38.  Orientation summary for synthetic fractures generated for the Topopah Spring Tuff Lower Lithophysal
zone (test 2).  (A) Equal-area stereonet plot of poles to fracture planes.  (B) Contours of poles to fracture planes

calculated with 1% area method.

August 19, 2005       KJS          
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Figure 39.  Summary of synthetic fracture radius distributions for the Topopah Spring Tuff  Lower Lithophysal zone
(test 1).  (A) Set 1 fractures are subhorizontal.  (B) Set 2 and 4 fractures are northwest-striking and steeply southwest

dipping.  (C) Set 3 and 5 fractures are north-south-striking and steeply west dipping.  (D) Set 6 fractures are east-
west-striking and steeply south dipping. 

Figure 40.  Summary of synthetic fracture radius distributions for the Topopah Spring Tuff Lower Lithophysal zone
(test 2).  (A) Set 1 fractures are subhorizontal.  (B) Set 2 and 4 fractures are northwest-striking and steeply southwest

dipping.  (C) Set 3 and 5 fractures are north-south-striking and steeply west dipping.  (D) Set 6 fractures are east-
west-striking and steeply south dipping. 

August 19, 2005       KJS          
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Summary data table from “DLS_Tptpul.XLS”:
DLS data Tptpul from the ECRB and ESF using a lower tracelength cut-off of 1 meter:

Count Dip (deg) Traclength 
above (m)

Traclength 
below (m)

Total 
Tracelength 

(m)

Displacement 
(m)

Displacement 
(cm)

True 
Spacing 

(m)

Linear   
Fracture   
Intensity      

(m-1)

All Mean = 1758 76.05 1.62 0.94 2.56 2.95 294.55
Median = 81.00 0.62 0.68 1.42 0.10 10.00

Std. Dev. = 14.49 3.12 0.91 3.59 20.77 2076.64
Skew = -2.19 4.21 1.54 3.87 8.36 8.36

Set 1 Mean = 538 80.56 1.19 0.90 2.09 1.08 107.85 2.82
Median = 83.00 0.61 0.66 1.44 0.08 8.00 0.75 1.34

Std. Dev. = 7.26 1.80 0.84 2.17 2.75 275.07 8.80 25.13
Skew = -0.98 4.07 1.25 3.56 3.68 3.68 8.48

Set 2 Mean = 1024 80.05 1.43 0.85 2.29 4.76 475.54 1.73
Median = 82.00 0.55 0.62 1.30 0.14 14.00 0.65 1.53

Std. Dev. = 6.90 2.85 0.79 3.25 27.98 2798.18 3.55 24.53
Skew = -0.68 4.29 1.42 4.00 6.24 6.24 6.00

Set 3 (Sub-H) Mean = 95 30.22 3.98 1.76 5.73 0.20 19.60 3.98
Median = 34.00 2.15 1.63 4.31 0.11 11.00 1.29 0.77

Std. Dev. = 11.89 5.51 1.53 6.18 0.18 18.47 6.59 20.80
Skew = -0.63 2.34 0.89 2.12 1.51 1.51 3.46

Set 4 (Random) Mean = 101 53.41 3.62 1.25 4.87 0.16 16.00
Median = 54.00 1.13 1.10 2.10 0.10 10.00

Std. Dev. = 4.07 5.72 1.08 6.42 0.16 15.72
Skew = -0.39 2.28 0.81 2.15 2.20 2.20

Total = 1758

Truncated Terzaghi

Summary data table from “DLS_Tptpmn_All.XLS”:
DLS data for Tptpmn in the ECRB and ESF using a lower tracelength cut-off of 1 meter (includes data from the Intensely Fractured Zone):

Count Dip (deg) Traclength 
above (m)

Traclength 
below (m)

Total 
Tracelength 

(m)

Displacement 
(m)

Displacement 
(cm)

True 
Spacing 

(m)

Linear 
Fracture 
Intensity 

(m-1)

All Mean = 13493 77.67 1.14 0.98 2.12 0.28 27.99
Median = 83.00 0.70 0.75 1.58 0.04 4.00

Std. Dev. = 16.77 1.89 1.00 2.26 2.64 264.22
Skew = -2.85 9.87 8.50 7.63 18.01 18.01

Set 1 Mean = 8919 82.91 1.15 1.03 2.18 0.10 10.00 0.42
Median = 84.00 0.77 0.84 1.70 0.04 4.00 0.19 5.20

Std. Dev. = 4.65 1.64 0.88 1.96 0.26 26.33 4.01 35.12
Skew = -0.63 7.91 1.26 5.44 6.13 6.13 77.99

Set 2 Mean = 2973 82.82 1.08 0.82 1.90 0.18 17.60 0.92
Median = 84.00 0.60 0.60 1.35 0.04 4.00 0.46 2.19

Std. Dev. = 5.05 2.32 0.79 2.62 0.86 86.46 1.50 23.62
Skew = -0.62 13.13 1.54 10.81 7.96 7.96 6.07

Set 3 (Sub-H) Mean = 679 15.95 1.34 1.14 2.47 0.13 13.40 1.19
Median = 17.00 0.70 0.50 1.54 0.05 5.00 0.52 1.92

Std. Dev. = 7.56 2.19 2.40 3.40 0.31 30.50 2.23 33.88
Skew = -0.06 3.89 11.09 6.22 4.15 4.15 6.49

Set 4 (Random) Mean = 922 55.55 1.11 0.91 2.02 1.90 190.16
Median = 60.00 0.52 0.56 1.27 0.06 6.00

Std. Dev. = 11.78 2.24 0.96 2.65 8.83 882.65
Skew = -0.65 6.38 1.38 5.08 5.56 5.56

Total = 13493

Truncated Terzaghi
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Summary data table from “DLS_Tptpmn_IFZ-only.XLS”:
DLS data for only the Intensely Fractured Zone (Stations 42+00 to 51+50) in the ESF using a lower tracelength cut-off of 1 meter:

Count DIP (degrees) Tracelength 
above (m)

Tracelength 
below (m)

Total Tracelength 
(m) Displacement (m) Displacement (cm)

True 
Spacing 

(m)

Linear 
Fracture 
Intensity 

(m-1)

All Mean = 4566 81.78 1.11 1.07 2.18 0.04 4.38
Median 84.00 0.84 0.95 1.80 0.03 3.00

Std. Dev. = 9.21 1.33 0.83 1.59 0.04 4.22
Skew = -4.77 5.36 0.86 4.13 2.83 2.83

Set 1 Mean = 3875 83.10 1.13 1.10 2.23 0.04 4.39 0.20
Median 84.00 0.87 0.98 1.85 0.03 3.25 0.12 8.27

Std. Dev. = 4.33 1.34 0.83 1.60 0.04 3.57 0.25 38.56
Skew = -0.66 5.64 0.81 4.40 1.86 1.86 5.89

Set 2 Mean = 525 83.23 1.09 0.95 2.04 0.04 4.41 1.34
Median 84.00 0.75 0.85 1.57 0.03 3.00 0.74 1.35

Std. Dev. = 4.95 1.34 0.78 1.63 0.05 4.97 1.77 19.06
Skew = -0.70 3.40 1.01 2.75 3.15 3.15 2.82

Set 3 (Sub-H) Mean = 54 17.76 0.62 0.59 1.21 2.08
Median 18.00 0.33 0.39 0.96 0.43 2.32

Std. Dev. = 6.87 0.89 0.73 1.10 5.19 14.27
Skew = -0.38 2.31 1.81 2.74 4.16

Set 4 (Random) Mean = 112 59.20 0.79 0.94 1.73 0.03 3.00
Median 65.00 0.51 0.58 1.37 0.03 3.00

Std. Dev. = 11.62 0.84 0.99 1.26
Skew = -1.23 1.43 1.57 1.33

Truncated Terzaghi
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ANALYSIS OF SUBSURFACE FAULT AND FRACTURE DATA FROM THE PTn

Introduction

The following notebook entries document work done to support Chapter 3.2 of “The
Nature of Flow in the Faulted and Fractured Paintbrush Nonwelded Hydrogeologic Unit”
(Intermediate Milestone 06002.01.262.640).  The only software used in these analyses
are the QA-controlled commercial-off-the-shelf programs Adobe® Illustrator® Version
CS2 (Adobe Systems, Inc., 2005), Microsoft® Excel 2002 (Microsoft Corporation, Inc.,
2002), and RockWare StereoStat® Version 1.3 (Rockware, Inc., 2004).

Analyses are based on a subset of the detailed line survey (DLS) data collected from
the Exploratory Studies Facility (ESF) (i.e., Barr, et al., 1996; Eatman, et al., 1997) that
are compiled in the Excel spreadsheet ESF_DLS_PTn.xls.  Analyses also use a
subset of the fracture data collected via full-periphery geologic mapping (FPGM)
conducted in the ESF (compiled in the Excel spreadsheet ESF_FPGM_PTn.xls.)

The basic analysis procedure is similar to that employed by Smart, et al., (2006),
including in some instances the application of correction to account for the bias
introduced by the ESF orientation (Terzaghi, 1965).  The first step is extraction of fault
and fracture data for only the PTn interval from the spreadsheet containing all DLS data
for ESF.  The DLS data was collected by station location and the corresponding
lithostratigraphic interval.  For the purposes of the report, this analysis employs a six
part subdivision of the Paintbrush Tuff nonwelded hydrogeologic unit (Table 3.2-1) that
generally corresponds to the unsaturated zone flow model layers as defined in Bechtel
SAIC Company, LLC. (2004).

Table 3.2-1.  Comparison Of Lithostratigraphy And Unsaturated Zone Flow Model Layers For the Paintbrush Nonwelded
Hydrogeologic Unit As Used In This Report.  Table Modified From Bechtel SAIC Company, LLC. (2004, Table 2-1). 

Lithostratigraphic Unit Unsaturated Zone
Flow Model Layer

Tiva Canyon Tuff, Crystal-Poor Member, Vitric Zone,
Nonwelded Subzone (Tpcpv1) PTn21

Pre-Tiva Canyon Bedded Tuff (Tpbt4) PTn22

Yucca Mountain Tuff (Tpy) PTn23

Pre-Yucca Mountain Bedded Tuff (Tpbt3) PTn24

Pah Canyon Tuff (Tpp) PTn25

Pre-Pah Canyon Bedded Tuff (Tpbt2);
Topopah Spring Tuff, crystal-rich member, vitric zone, non- to partially welded subzone (Tptrv3);

Topopah Spring Tuff, crystal-rich member, vitric zone, moderately welded subzone (Tptrv2)
PTn26
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The exact breakdown of subdivisions as defined in Bechtel SAIC Company, LLC. (2004)
places portions of the Yucca Mountain Tuff in the PTn22, PTn23, and PTn24
unsaturated zone flow model layers.  This breakdown, however, can not be used for this
analysis because the necessary detail on stratigraphic position is not included in the
fracture and fault data sets collected in the Exploratory Studies Facility (Table 3.2-2). 
Consequently, this analysis treats the all data from the Yucca Mountain Tuff as being
part of the PTn23 unsaturated zone flow model layer.

Table 3.2-2.  Summary Of Digital Data Sets For Fault And Fracture Data Collected By The DOE From The Paintbrush
Nonwelded Tuff In The Exploratory Studies Facility.

Data Tracking Number Description

GS970808314224.008 Fracture Type data from South Ramp-Tunnel at the ESF, and Yucca Mountain
Project Detailed Line Survey-Data Collected from Station 65+00 to 70+00.

GS970808314224.010 Fracture Type data on South Ramp-Tunnel at the ESF, and Yucca Mountain Project
Detailed Line Survey-Data Collected from Station 70+00 to 75+00.

GS970808314224.012
Fracture Type data from Detailed Line Survey-data collected from station 75+00 to
78+77 on the South Ramp at the ESF in Yucca Mountain area, 03/06/1997 to
06/17/1997.

GS971108314224.021 Revision 1 of Detailed Line Survey Data, Station 4+00 to Station 8+00, North Ramp,
Exploratory Studies Facility.

GS971108314224.022 Revision 1 of Detailed Line Survey Data, Station 8+00 to Station 10+00, North Ramp,
Exploratory Studies Facility.

GS971108314224.023 Revision 1 of Detailed Line Survey Data, Station 10+00 to Station 18+00, North
Ramp, Exploratory Studies Facility.

MO9904MWDFPG16.000 Fracture Attitude data for full periphery geotechnical mapping of strike and dip data
entry correction analysis.

Data from DLS

Once the initial extraction of DLS-based fracture and fault data was completed,
separate “sheets” were used to analysis the data in different categories.  The following
“sheets” were developed:

1. PTn-original – all DLS-based fracture and fault data from ESF for PTn sorted by
station position.

2. PTn-Strike+Dip Sorted – all DLS-based fracture and fault data from ESF for PTn
separated into orientation-based fracture sets, and with Terzaghi correction
applied.

3. PTn-Displacement – only fractures or faults with recorded offsets sorted by
“Unsaturated Zone Flow Model Layer.”

4. Sorted - Lithostratigraphy – all DLS-based fracture and fault data from ESF for
PTn sorted by “Lithostratigraphic Unit.”

5. Sorted - PTn Unit – all DLS-based fracture and fault data from ESF for PTn
sorted by “Unsaturated Zone Flow Model Layer.”
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Data from FPGM

Once the initial extraction of FPGM-based fracture data was completed, separate
“sheets” were used to analysis the data in different categories.  The following “sheets”
were developed:

1. Original Data – all FPGM-based fracture data from ESF for PTn sorted by station
position.

2. Original - Strike+Dip Sorted – all FPGM-based fracture data from ESF for PTn
separated into orientation-based fracture sets, and with Terzaghi correction
applied.

3. Sorted by Lithostratigraphy – all FPGM-based fracture data from ESF for PTn
sorted by “Lithostratigraphic Unit.”

4. Sorted by PTn # – all FPGM-based fracture data from ESF for PTn sorted by
“Unsaturated Zone Flow Model Layer.”

Additional supporting tables and figures:

Table 3.2-3.  Summary Of Exploratory Studies Facility Tunnel Length, Number, And Number Per Unit Length (P10) of
Fractures And Faults For Each Paintbrush Tuff Nonwelded Hydrogeologic Unit As Determined By Full-Periphery

Geologic Mapping and Detailed Line Survey.  The Intensity Measure P10 Is Defined In Dershowitz and Herda, 1992.  

Unsaturated
Zone Flow

Model Layer

Tunnel
Length, m

[ft]

Full-Periphery Geologic Mapping Detailed Line Survey

Fractures Fractures Faults

# P10, m-1 [ft-1] # P10, m-1 [ft-1] # P10, m-1 [ft-1]

All 496 [1628] 809 1.6 [0.5] 340 0.7 [0.2] 126 0.3 [0.1]

PTn21 109 [358] 308 2.8 [0.9] 90 0.8 [0.3] 24 0.2 [0.1]

PTn22 9 [30] 6 0.7 [0.2] 2 0.2 [0.1] 2 0.2 [0.1]

PTn23 2 [8] 5 2.2 [0.7] 5 2.2 [0.7] 2 0.9 [0.3]

PTn24 45 [147] 45 1.0 [0.3] 19 0.4 [0.1] 15 0.3 [0.1]

PTn25 131 [431] 144 1.1 [0.3] 80 0.6 [0.2] 22 0.2 [0.1

PTn26 200 [655] 301 1.5 [0.9] 144 0.7 [0.3] 61 0.3 [0.1]
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Table 3.2-4.  Summary Of Observed (i.e., Raw) Fracture Spacings And Intensities (i.e., Inverse Of Spacing) From The PTn
Interval Exposed In The Exploratory Studies Facility Based On Measurements Collected Via The Full-Periphery Geologic
Mapping Technique.  Spacing Was Calculated With An Upper Bound Of 10 m [38 ft] {i.e., Spacing Was Not Calculated for

Fracture Pairs That Were $10 m [38 ft] Apart}.

Unsaturated Zone Flow
Model Layer

Number
(%) Measure Spacing

(m) 
Intensity

(m-1) 

All 809
(100%)

Mean 0.59 1.71

Median 0.32 3.12

Std. Dev 0.75 1.33

PTn21 308
(38%)

Mean 0.36 2.76

Median 0.21 4.76

Std. Dev 0.46 2.19

PTn22 6
(<1%)

Mean 0.82 1.22

Median 0.12 8.33

Std. Dev 1.45 0.69

PTn23 5
(<1%)

Mean 0.52 1.91

Median 0.29 3.45

Std. Dev 0.65 1.53

PTn24 45
(6%)

Mean 1.01 0.99

Median 0.76 1.32

Std. Dev 0.86 1.16

PTn25 144
(18%)

Mean 0.93 1.08

Median 0.62 1.61

Std. Dev 1.01 0.99

PTn26 301
(37%)

Mean 0.54 1.85

Median 0.34 2.94

Std. Dev 0.67 1.50

Note: PTn21 consists of Tpcpv1; PTn22 consists of Tpbt4; PTn23 consists of Tpy; PTn24 consists of Tpbt3; PTn25 consists of
Tpp; PTn26 consists of Tpbt2, Tptrv3, and Tptrv2.
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Table 3.2-6.  Summary Of Observed (i.e., Raw) Fracture Spacings, Intensities (i.e., Inverse Of Spacing), And Trace Lengths
From The PTn Interval Exposed In The Exploratory Studies Facility Based On Measurements Collected Via The Detailed
Line Survey Technique.  Spacing Was Calculated With An Upper Bound Of 10 m [38 ft] {i.e., Spacing Was Not Calculated

for Fracture Pairs That Were $10 m [38 ft] Apart}.

Unsaturated Zone Flow
Model Layer

Number
(%) Measure Spacing

(m) 
Intensity

(m-1) Trace Length (m)

All 340
(100%)

Mean 1.27 0.79 3.55

Median 0.62 1.61 2.20

Std. Dev 1.61 0.62 4.68

PTn21 90
(26%)

Mean 1.48 0.67 3.20

Median 0.67 1.49 2.50

Std. Dev 1.88 0.53 2.79

PTn22 2
(<1%)

Mean 0.03 33.33 3.09

Median 0.03 33.33 3.09

Std. Dev n.a. n.a. 2.06

PTn23 5
(1%)

Mean 0.31 3.20 2.24

Median 0.28 3.64 0.91

Std. Dev 0.26 3.91 2.32

PTn24 19
(6%)

Mean 2.04 0.49 4.80

Median 0.91 1.10 2.76

Std. Dev 2.13 0.47 5.61

PTn25 80
(24%)

Mean 1.58 0.63 5.56

Median 0.96 1.04 3.56

Std. Dev 1.74 0.58 6.84

PTn26 144
(42%)

Mean 0.91 1.10 2.86

Median 0.40  2.47 1.52

Std. Dev 1.16 0.86 4.00

Note: PTn21 consists of Tpcpv1; PTn22 consists of Tpbt4; PTn23 consists of Tpy; PTn24 consists of Tpbt3; PTn25 consists of
Tpp; PTn26 consists of Tpbt2, Tptrv3, and Tptrv2.
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Table 3.2-5.  Comparison Of Uncorrected And True (i.e., Corrected) Spacing And Intensity (i.e., Inverse Of Spacing) For The 809 Fractures From The PTn Interval In The
Exploratory Studies Facility Based On Data Collected Via Full-Periphery Geologic Mapping Technique.  Fracture Sets Determined From Stereographic Analysis Using
Criteria Specified Below.  Spacing Was Calculated With An Upper Bound Of 10 m [38 ft] {i.e., Spacing Was Not Calculated for Fracture Pairs That Were $10 m [38 ft]

Apart}.

Set Number
(%)

Mean Orientation
(Strike/Dip)

Fisher Dispersion
Coefficient Measure

Uncorrected True

Spacing
(m)

Intensity
(m-1) 

Spacing
(m) 

Intensity
(m-1) 

1 661
(82%) 186°/78° 8.571

Mean 0.70 1.43 0.64 1.55

Median 0.38 2.63 0.34 2.94

Std. Dev 0.89 1.13 0.82 1.23

2 94
(11%) 106°/83° 4.876

Mean 2.46 0.41 0.67 1.50

Median 1.61 0.62 0.45 2.20

Std. Dev 2.40 0.42 0.64 1.56

3 54
(7%) 003°/13° 13.515

Mean 2.71 0.37 0.67 1.50

Median 1.87 0.53 0.47 2.14

Std. Dev 2.67 0.37 0.65 1.54

Set 1 = Fracture strikes of 145° to 235° (325° to 055°) and dips of >40°.
Set 2 = Fracture strikes of 056° to 144° (236° to 324°) and dips of >40°.
Set 3 = Fractures with dips of #40°.
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Table 3.2-7.  Comparison Of Uncorrected And True (i.e., Corrected) Spacing And Intensity (i.e., Inverse Of Spacing), And Trace Length For The 340 Fractures From The
PTn Interval In The Exploratory Studies Facility Based On Data Collected Via Detailed Line Survey Technique.  Fracture Sets Determined From Stereographic Analysis
Using Criteria Specified Below.  Spacing Was Calculated With An Upper Bound Of 10 m [38 ft] {i.e., Spacing Was Not Calculated for Fracture Pairs That Were $10 m [38

ft] Apart}.

Set Number
(%)

Mean Orientation
(Strike/Dip)

Fisher Dispersion
Coefficient Measure

Uncorrected True
Trace Length

(m)Spacing
(m)

Intensity
(m-1) 

Spacing
(m) 

Intensity
(m-1) 

1 282
(83%) 188°/80° 8.310

Mean 1.32 0.76 1.23 0.81 3.57

Median 0.73 1.37 0.67 1.50 2.26

Std. Dev 1.56 0.64 1.47 0.68 4.32

2 41
(12%) 127°/88° 7.857

Mean 2.60 0.39 1.08 0.93 2.49

Median 1.60 0.63 0.60 1.65 1.60

Std. Dev 2.89 0.35 1.33 0.75 1.99

3 17
(5%) 012°/11° 16.617

Mean 2.43 0.41 0.59 1.70 5.89

Median 0.89 1.13 0.21 4.67 3.50

Std. Dev 2.54 0.39 0.62 1.63 10.86

Set 1 = Fracture strikes of 150° to 240° (330° to 060°) and dips of >40°.
Set 2 = Fracture strikes of 061° to 149° (241° to 329°) and dips of >40°.
Set 3 = Fractures with dips of #40°.
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Table 3.2-8.  Summary Of Observed (i.e., Raw) Fracture Spacings, Intensities (i.e., Inverse Of Spacing), Trace Lengths,
And Offsets From Faults In The PTn Interval Exposed In The Exploratory Studies Facility Based On Measurements

Collected Via The Detailed Line Survey Technique.  Spacing Was Calculated With An Upper Bound Of 10 m [38 ft] {i.e.,
Spacing Was Not Calculated for Fracture Pairs That Were $10 m [38 ft] Apart}.

Unsaturated
Zone Flow

Model Layer

Number
(%) Measure Spacing

(m) 
Intensity

(m-1) Trace Length (m) Offset
(cm)

All 126
(100%)

Mean 2.23 0.45 5.38 37

Median 1.30 0.77 3.25 15

Std. Dev 2.14 0.47 5.74 68

PTn21 24
(19%)

Mean 1.96 0.51 3.45 61

Median 1.19 0.84 3.07 17

Std. Dev 1.92 0.52 2.19 101

PTn22 2
(2%)

Mean 0.03 33.33 3.09 12

Median 0.03 33.33 3.09 12

Std. Dev n.a. n.a. 2.06 5

PTn23 2
(2%)

Mean 1.25 0.80 4.39 25

Median 1.25 0.80 4.39 25

Std. Dev n.a. n.a. 2.49 21

PTn24 15
(12%)

Mean 1.68 0.60 5.36 32

Median 0.88 1.14 2.80 15

Std. Dev 1.71 0.58 6.01 38

PTn25 22
(17%)

Mean 3.33 0.30 9.25 42

Median 3.27 0.31 5.65 25

Std. Dev 2.19 0.46 7.42 43

PTn26 61
(48%)

Mean 1.74 0.58 4.78 27

Median 1.00 1.00 2.95 11

Std. Dev 1.80 0.55 5.52 66

Note: PTn21 consists of Tpcpv1; PTn22 consists of Tpbt4; PTn23 consists of Tpy; PTn24 consists of Tpbt3; PTn25 consists of
Tpp; PTn26 consists of Tpbt2, Tptrv3, and Tptrv2.
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PTn21
109 m
[358 ft]

22%

PTn22
9 m

[30 ft]
2%

PTn23
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[8 ft]
<1%

PTn24
45 m

[147 ft]
9%

PTn25
131 m
[431 ft]

26%

PTn26
200 m
[655 ft]

41%

Figure 3.2-6  Summary Of Exposed Length and Percentage For Each Unsaturated Zone
Flow Model Layer Of The Paintbrush Tuff Nonwelded Hydrogeologic Unit As Exposed In

The Exploratory Studies Facility.  Total Exposed Length Is 496 m [1628 ft]. 

PTn21
n = 24
19%

PTn22
n = 2
2%

PTn23
n = 2
2%PTn24

n = 15
12%

PTn25
n = 22
17%

PTn26
n = 61
48%

Figure 3.2-7  Summary Of Number Of Faults And Percentage For Each Unsaturated Zone
Flow Model Layer Of The Paintbrush Tuff Nonwelded Hydrogeologic Unit As Exposed In

The Exploratory Studies Facility.  Fault Data Collected Via Detailed Line Survey
Technique (Total of 126 Measurements).
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(A)

PTn21
n = 90
26%

PTn25
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24%

PTn26
n = 144

42%
PTn22
n = 2
<1%

PTn23
n = 5
1%

PTn24
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Figure 3.2-8  Summary Of Number Of Fractures And Percentage For Each Unsaturated
Zone Flow Model Layer Of The PTn As Exposed In The Exploratory Studies Facility.  (A)

Fracture Data Collected Via Full-Periphery Geologic Mapping Technique (Total of 809
Measurements).  (B) Fracture Data Collected Via Detailed Line Survey Technique (Total of

340 Measurements).
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PRELIMINARY ANALYSIS OF FAULT AND FRACTURE DATA FROM ALCOVE 4

During the NRC’s review of "The Nature of Flow in the Faulted and Fractured
Paintbrush Nonwelded Hydrogeologic Unit" (Intermediate Milestone 06002.01.262.640),
the following question was raised: 

The DOE performed injection tests in Alcove 4.  Can you comment on the
representativeness of Alcove 4 in terms of all the data presented in
section 3.2?

A preliminary analysis of fault and fracture data from Alcove 4 was initiated to address
this question.  It was determined that the DLS data for Alcove 4 is reported by Barr et al.
(1996) to be contained as part of DTN GS960908314224.020.  A “ZIP” file labelled with
this DTN number was provided to CNWRA as part of two CD’s containing ESF and
ECRB fracture data, but it was found that the file on the CD contains only FPGM files for
the north ramp portion of the ESF and the FPGM file for Alcoves 3 and 4 (filename is
“alc3_4.dwg”).  An exhaustive search of the data provided by DOE has not found the
Alcove 4 DLS data (although the CNWRA was provided with DLS data for Alcoves 2, 3,
5, and 6).

To attempt to address the NRC’s question, the fracture and fault data documented on
the Alcove 4 FPGM were manually extracted and input into a spreadsheet file (filename
(Alcove-4_FPGM.xls”).  The FPGM contains 39 recorded fracture orientations (strike &
dip) and 3 faults (strike, dip, & rake).  The figure on the next page contains stereonet
plots of the fractures (part d) and faults (part e) from Alcove 4 FPGM with a comparison
to the fractures from the PTn in the ESF (part a = FPGM; part b = DLS) and the faults
from the PTn in the ESF (part c).

Based on this preliminary analysis, we conclude that fractures and faults recorded on
the FPGM from Alcove 4 have similar orientations to the fractures and faults from the
PTn as characterized in the ESF. The majority of Alcove 4 fractures strike north-south
and are steeply dipping ($70°). Comparison of fracture intensity between Alcove 4 and
the rest of the PTn is not possible at this time. 
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Equal-area stereonet plots fracture and fault data for Paintbrush nonwelded
hydrogeologic unit.  (a) Poles to fractures from full-periphery geologic mapping of PTn
from north and south ramps of ESF.  (b) Poles to fractures from detailed line survey of

PTn from north and south ramps of ESF.  (c) Poles to faults from detailed line survey of
PTn from north and south ramps of ESF.  (d) Fractures (black) and faults (blue) from
full-periphery geologic mapping of Alcove 4.  Red circles are measured slip indicators

(i.e., slickenlines on faults.  (e) Poles to fractures and faults from full-periphery geologic
mapping of Alcove 4.
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